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Before you begin

Completing the exercises
To learn software, we must use the software. This course includes hands-on exercises that allow you to
practice what you learned.

Note: The exercises in this course were originally developed for the Pega Platform Foundation and
Business Architect Essentials courses. You may notice slight discrepancies with the exercise
environment provided with this course. These discrepancies do not affect the changes you make while
completing the exercises, though they do affect the contents of the rules you update.

The exercises provide a business problem to be solved. To help you complete the exercises, two levels
of support are provided:

l Approach - specifies the high level steps you need to perform to solve the business problem

l Procedure - shows the series of steps or instructions that are designed to help you understand how
to complete the exercise

It is our goal that you can complete the exercises using the business need and approach. Use the
procedure to check your work or as a last resort to complete the exercise.
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Designing a case life cycle

Exercise: Adding a case type to your
application

Scenario
TGB reimburses employees for necessary and reasonable business expenses incurred in the conduct
of TGB's business. TGB wants to ensure business expenses are reported accurately, and reimbursed in
a timely and consistent manner according to company policy.

TGB decided to add an Expense Report case type to the HR Apps application. The objective of the
Expense Report case type is to provide an automated solution for managing expense reimbursements
that will help resolve deficiencies found in the current manual expense reimbursement process.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Create a new case type used to model the work accomplished in the expense reimbursement business
process.

Detailed steps
Follow these steps to add a case type to your application.

1. In the lower right corner of the Pega Express dashboard, click Turn editing on.
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2. In the navigation panel, click Cases to view a list of current case types.

3. Click Create new case type.

4. In the Create new field, enter Expense Report as the name of the case type, and then click Next.

5. Click Done to add the case type to the application. You are returned to the Pega Express
Dashboard.
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Exercise: Adding stages to a case type

Scenario
TGB reimburses employees for necessary and reasonable business expenses incurred in the conduct
of TGB's business. TGB wants to ensure business expenses are reported accurately, and reimbursed in
a timely and consistent manner according to company policy.

The first goal when defining the life cycle of a case is to summarize the business process by defining
the stages of the case.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Define the case life cycle by describing the stages of the expense report business process.

Employees submit an expense reimbursement request using the Expense Report case type. The
expense reimbursement request is routed to the appropriate reviewers for approval, and then goes to
the accounting office for payment processing.

Detailed steps
Follow these steps to add stages to a case type.

1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.
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3. From the list of available case types, click Expense Report.

4. Click Life cycle to edit the case life cycle design.

5. Click Add stages.
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6. In the text box of the first stage, enter New.

7. Click + Add stage.

8. In the text box of the second stage, enter Review.

9. Click + Add stage again, and then enter Payment as the name of the third stage.

10. Click Done to save your changes. You are returned to the Pega Express Dashboard.
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Exercise: Adding process steps to a stage

Scenario
TGB reimburses employees for necessary and reasonable business expenses incurred in the conduct
of TGB's business. TGB wants to ensure business expenses are reported accurately, and reimbursed in
a timely and consistent manner according to company policy.

The goal for this iteration is to identify the key process steps that users accomplish as they work on a
case.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Add process steps to the appropriate stages in the Expense Report case type to define the set of tasks
that must be accomplished to resolve an expense reimbursement request.

Employees must provide their employee information and an itemized list of expenses. The expense
reimbursement request is routed to the employee's department manager for review. If necessary, the
expense reimbursement request may be routed to the department head for additional review.
Approved expense reimbursement requests are routed to the accounting office for payment
processing.

Detailed steps
Follow these steps to add process steps to stages in a case type.

1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.
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3.1. From the list of available case types, click Expense Report.

2. Click Life cycle to edit the case life cycle design.

4. In the lower right corner, click Add processes?.

5. Click Add processes.
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6. In the first stage of the Expense Report case type, click + Add process.

7. In the first step of the new process, click the name of the step, and then change the name to Enter
Expense Details.
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8. In the second stage of the Expense Report case type, click + Add Process.

Note: Adding a Process in Pega 7.2 automatically creates a Collect Information step by default.

9. Hover over the first step in the process, and click the X to remove the step.

Note: Remove the default Collect Information step when a different type of step is required.

10. In the second stage of the Expense Report case type, click + Add step.
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11. Select the Approve/Reject step.

12. In the text field of the new step, enter Manager Review.

13. Hover over the second stage, and click the down arrow.

14. From the drop-down menu, select Add process .
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15. Delete the first step in the second process, and then add a new Approve/Reject step.

16. In the Approve/Reject step, enter Director Review.

17. Add a process to the third stage. Accept the default name for the first step in the new process.

18. Click Done to save your changes. You are returned to the Pega Express dashboard.
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Assigning work

Exercise: Routing work to case participants

Scenario
Now that you have defined the process steps of the Expense Report case, you can configure the
assignments so that each request can be approved by the correct party.

To ensure expenses are reported accurately, all expense reimbursement requests must be reviewed by
the department manager. If approved, some expense reimbursement requests may require director
review. All approved expense reimbursement requests are sent to the accounting department for final
validation and processing.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Configure the Manager Review step so the request for expense reimbursement is routed to the
employee's manager.

Configure the Director Review step so the request for expense reimbursement is routed to the
director.

Detailed steps
Follow these steps to assign work to case participants.

1. In the lower right corner of the Pega Express dashboard, click Turn editing on.
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2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. Click Life cycle to edit the case life cycle design.

5. Select the Manager Review step.

6. On the General tab of the contextual property panel, click Specific user.

7. From the second drop-down list, selectManager to route the work to the employee's manager.
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8. Select the Director Review step.

9. On the General tab of the contextual property panel, click Specific user.

10. From the second drop-down list, select Director.
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11. Select the Payment step.

12. On the General tab of the contextual property panel, clickWork Queue.

13. From the drop-down list, select Accounts Payable.

14. Click Done to save your changes. You are returned to the Pega Express Dashboard.



19
©2017 Pegasystems Inc.

Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.

3. The Expense Report case type does not yet have any fields defined. Click Done to advance to the
Enter Expense Details user view.

4. Click Advance the case or Complete Stage to move the case to the Review stage.
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5. In the upper right corner of the Work Area, under Open assignments, verify the case has been
assigned to the Manager.

6. To open and complete the assignment as the Manager, click Please approve or reject this
Expense Report.

7. Click Approve to advance the case to the next step.

8. Again, in the upper right corner of the Work Area, under Open assignments, verify the case has
been assigned to the Director.
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9. To open and complete the assignment as the Director, click Please approve or reject this Expense
Report.

10. Click Approve to advance the case to the next step.

11. Under Open assignments, verify the case has been assigned to the Accounts Payable Work queue
(AP@TGB).
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Enforcing service levels

Exercise: Adding a service level agreement
(SLA) to a case

Scenario
TGB's business policies indicate requests for expense reimbursement must be completed within five
business days.

To meet this requirement, TGB has established a goal of four business days for processing requests for
expense reimbursement. However, all requests for expense reimbursement must be completed within
five business days.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Configure the Expense Report case type with a goal and a deadline.

If a request for expense reimbursement is not completed by the goal of four days, the urgency of the
case shall be increased by a value of 10, and a notification shall be sent to the department manager. If
a request for expense reimbursement is not completed by the deadline of five days, the urgency of the
case shall be increased by a value of 20, and a notification shall be sent to the department manager.

Detailed steps
Follow these steps to add a service level to a case.
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1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. In the upper right corner, click the Gear icon.

5. Click Goal & deadline to edit the goal and deadline settings.
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6. Select the Consider goal and deadline check box.

7. In the Days field for the Goal, enter 4. This is the preferred time frame in which a request for
expense reimbursement should be completed.

8. In the Increase urgency by field, enter 10.

9. From the Perform actions drop-down list, select Notify Manager.

10. In the Days field for the Deadline, enter 5. This is the time frame in which the case must be
completed.

11. In the Increase urgency by field, enter 20.

12. From the Perform actions drop-down list, select Notify Manager.
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13. Click Done to save your changes. You are returned to the Pega Express Dashboard.

Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.

3. The Expense Report case type does not yet have any fields defined. Click Done to advance to the
Enter Expense Details user view.
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4. Verify the Goal, Deadline, and Urgency entered in the exercise.
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Exercise: Adding a service level agreement
(SLA) to an assignment

Scenario
TGB's business policies indicate requests for expense reimbursement must be completed within five
business days. To meet this requirement, TGB has established a goal of one business day for managers
to complete reviews of request for expense reimbursements. However, managers must complete
reviews of requests for expense reimbursements no later than two business days after receiving the
assignment.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your assignment
Configure the Manager Review assignment with a goal and deadline. Define the goal as one day,
increase the urgency of the assignment by a value of 10, and notify the manager if the goal is missed.
Define the deadline as two days, increase the urgency of the assignment by a value of 25, and notify
the manager if the deadline is missed.

If a manager does not complete the review by the goal, the urgency of the case shall be increased by a
value of 10, and a reminder to complete the review before deadline shall be sent to the department
manager. If the manager does not complete the review by the deadline, the urgency of the case shall
be increased by a value of 25, and a notification shall be sent to the department manager indicating
that the deadline was missed and a review must be completed immediately.

Detailed steps
Follow these steps to add a service level to an assignment.

1. In the lower right corner of the Pega Express dashboard, click Turn editing on.
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2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. Click Life cycle to edit the case life cycle design.

5. Select the Manager Review step.

6. On the Goal & Deadline tab of the contextual property panel, select the Consider goal and
deadline check box.
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7. In the Days field for the Goal, enter 1.

8. In the Increase urgency by field, enter 10.

9. From the Perform actions drop-down list, select Notify Manager.

10. In the Days field for the Deadline, enter 2.

11. In the Increase urgency by field, enter 25.

12. From the Perform actions drop-down list, select Notify Manager.

13. Click Done to save your changes. You are returned to the Pega Express Dashboard.
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Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.

3. The Expense Report case type does not yet have any fields defined. Click Done to advance to the
Enter Expense Details user view.

4. Verify the Deadline entered in the exercise.

Note: When an SLA is added to an assignment, the Deadline is the only visible service level. The
Goal is not visible to the end user.
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Creating user views

Exercise: Configuring a standard user view

Scenario
The initial case life cycle design for the Expense Report case type is complete. Now you can configure
user views to collect and display the information needed to process a request for expense
reimbursement.

One of the requirements for the Expense Voucher case type is: Employees must be able to submit an
itemized list of expenses for reimbursement. To satisfy this requirement, you must configure a user view
to collect the employee's personal details (such as name and ID) and the date the expense
reimbursement request is submitted.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your Assignment
Configure the default Create user view with the following form elements:

Name of Form
Element

How to Display the Form
Element

Can the Form Element be
Edited?

Date Submitted Date only Optional

Employee Details Field group NA

Employee ID Text (single line) Optional

First Name Text (single line) Optional

Last Name Text (single line) Optional

Department Picklist Optional

Detailed Steps

Configure the standard user view
Follow these steps to configure a standard user view.
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1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. Click Views to configure user views for the Expense Report case type.

5. Select the standard Create view.
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6. Click Edit this view to open the form for editing.

7. In the first column, enter Date Submitted as the name of the field.

8. In the second column, select Date only as the field display type.

9. Click + Add field to add another field.

10. In the first column in the second row, enter Employee Details.

11. In the second column in the second row, select Field group as the field display type. Pega adds a
nested field element automatically.
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12. In the third row, enter Employee ID.

13. Click + Add field to Employee Details to add a second row of fields to the Employee Details field
group.

14. In the blank field, enter First Name.

15. Click + Add field to Employee Details to add a third row of fields to the Employee Details field
group.

16. In the blank field, enter Last Name.

17. Click + Add field to Employee Details to add a fourth row of fields to the Employee Details field
group.

18. In the blank field, enter Department.
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Configure a Picklist for the Department field
Your assignment states the Department field must be a Picklist. Follow these steps to configure a local
list of values for the Picklist:

1. In the Department field, change the display mode type to Picklist.

2. Click the Gear icon at the end of the Department form element row.

3. In the DISPLAY AS field, use the default Drop-down list option.

4. In the first field under LIST CHOICES, enter Global Services for the first department name.

5. Click + Add choice twice, and then enter Sales and Customer Support as the other department
names.
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6. Click Submit to save the Picklist.

7. Click Done to save your changes to the user view.

8. Click Done to save your changes to the case type. You are returned to the Pega Express dashboard.

Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.
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The fields you added to the standard Create view are displayed.
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Exercise: Configuring a custom user view

Scenario
After the initial case life cycle design for the Expense Report case type is complete, you can configure
user views to collect and display the information needed to process a request for expense
reimbursement.

One of the requirements for the Expense Report case type is: Employees must be able to submit an
itemized list of expenses for reimbursement.

To satisfy this requirement, you must configure a user view to collect the details related to the itemized
list of expenses.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your Assignment
For the Enter Expense Details step, configure a user view with a repeating field group that allows the
employee to enter a list of itemized expenses. The user view must contain the following items:

Name of Form
Element

How to Display the Form
Element

Can the Form Element be
Edited?

Expenses Field group list Optional

Expense Item Text (single line) Optional

Expense Amount Currency Optional

Date of Purchase Date only Optional

Detailed Steps
Follow these steps to configure a user view with a repeating group of fields.
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1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. Click Lifecycle to edit the case life cycle design.

5. In the New stage, select the Enter Expense Details step.



41
©2017 Pegasystems Inc.

6. Click Lifecycle to edit the Case Lifecycle Design.

7. In the contextual properties panel, click Configure view.

8. In the first column, enter Expenses.

9. In the second column, select Field group (list) as the display mode type.
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10. In the first field in the second row, enter Expense Item.

11. In the second column, use the default Text (single line) as the display mode type.

12. Click + Add field to Expenses twice.

13. In the first field in the third row, enter Expense Amount, and then select Currency as the display
mode type.

14. In the first field in the fourth row, enter Date of Purchase, and then select Date only as the display
mode type.
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15. Click Done to save your changes to the user view.

16. Click Done to close the case type. You are returned to the Pega Express dashboard.

Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.

3. The Employee Details user view is displayed.

Note: Entering sample values in the fields for this screen is not required. Enter values at your own
discretion.
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4. Click Done to advance to the Enter Expense Details user view.

The fields you added to the custom user view are displayed.
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Exercise: Configuring the standard Review
form

Scenario
After the initial case life cycle design for the Expense Report case type is complete, you can configure
user views to collect and display the information needed to process a request for expense
reimbursement.

One of the requirements for the Expense Report case type is: Managers must be able to review all
requests for reimbursement of expenses. To satisfy this requirement, you must configure a user view to
display the date the expense reimbursement request was submitted, the employee's details, and the
itemized list of expenses.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author@tgb rules

Your Assignment
Configure the default Review user view with the following form elements:

Name of Form
Element

How to Display the Form
Element

Can the Form Element be
Edited?

Date Submitted Date only Set to Read-only by default

Employee Details Field group Set to Read-only by default

Expense Details Field Group (list) Set to Read-only by default

Detailed Steps
Follow these steps to configure a standard user view and reuse existing fields.
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1. In the lower right corner of the Pega Express dashboard, click Turn editing on.

2. In the navigation panel, click Cases to view a list of current case types.

3. From the list of available case types, click Expense Report.

4. Click Views to configure user views for the Expense Report case type.

5. Select the standard Review user view.
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6. Click Edit this view to open the form for editing.

In the first row, the Date Submitted field is available.

7. Click Fields to view a list of available fields to add to the user view.
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8. From the list of available fields, hover over Employee Details and click the Plus sign icon to add the
field group to the user view.

The Employee Details field group is displayed on the form.

9. From the list of available fields, hover over Expenses and click the Plus sign icon to add the field
group to the user view.

The Expenses field group list is displayed on the form.
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10. Click Done to save your changes to the user view.

11. Click Done to save your changes to the case type. You are returned to the Pega Express dashboard.

Verify your work
1. On the Pega Express dashboard, click New.

2. Click Expense Report.

3. In the Employee Details form, enter sample data, and then click Done.
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4. In the Enter Expense Details form, enter at least one row of sample data, and then click Submit.

The case advances to the Review stage, and the expense report details are displayed in the standard
Review form.

Note: You may have to scroll down the page to see the results.
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Managing case life cycle exceptions

Exercise: Adding alternate stages to the case
life cycle

Scenario
TGB's business policies indicate all expense reimbursement requests are routed to the appropriate
reviewers for approval. Then, the requests go to the accounting office for payment processing. If a
request for expense reimbursement is rejected by the department manager or the director, the
employee must be provided an opportunity to reconcile the request. Also, if any expense items are
billable to a customer, or the expense items meet certain criteria, the request for expense
reimbursement must be audited.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Add alternate stages to the Expense Report case life cycle to model the exceptions for a rejected
request for expense reimbursement, or a required audit of a request for expense reimbursement.

Detailed steps
Follow these steps to add alternate stages to a case type.
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1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. In the Alternate stages section, click + Add alternate stage to add an alternate stage to the case
type.

4. In the text field of the second stage, enter Auditing.

5. Select the Approval Rejection stage, and change the name to Rejection.

6. Click Save to save your changes. The alternate stages are displayed as part of the Expense Voucher
case life cycle.
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Exercise: Controlling stage transitions using
the Approve/Reject step

Scenario
TGB's business policies indicate all expense reimbursement requests are routed to the appropriate
reviewers for approval. If a request for expense reimbursement is rejected by the department
manager or the director, the employee must be provided an opportunity to reconcile the request. After
the employee reconciles the request for expense reimbursement, the request should be automatically
routed back to the Review stage.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Configure the Approve/Reject steps for the Manger Review and the Director Review process steps so
that the case flow transitions to the Reject stage when a request for expense reimbursement is
rejected by either the manager or the director.

Detailed steps
Follow these steps to control stage transitions in a case life cycle using the Approve/Reject step.

1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. In the Review stage, select the Manager Review step.
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4. On the Flow tab of the contextual property panel, confirm the option for If APPROVED then is set
to Continue.

5. In the Set status list, enter the character p to invoke a list of available options and select Pending-
Approval.

6. Set the option for If REJECTED then to Change Stage.

7. In the To drop-down list, select the Rejection stage.

8. In the Set status list, select Pending-Qualification.

9. Select the Director Review step and confirm the If APPROVED then option is set to Continue.

10. In the Set status list, select Pending-Fulfillment.

11. Set the option for If REJECTED then to Change stage.
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12. In the To drop-down list, select the Rejection stage.

13. In the Set status list, select Pending-Qualification.

14. Click Save to save your changes.

Verify your work
Create a new expense report case to test your changes.

1. In the upper right corner of the Case Designer work space, click Run to create a new instance of the
Expense Report case type.

2. On the New: Expense Report screen, click Done to advance to the Enter Expense Details step.

Note: Entering data on this screen is optional.

3. Click Complete stage to advance the case to the Review stage.

4. In the Open assignments section, click Please approve or reject this Expense Report to open
the assignment.

Notice the case is in the Review stage.
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5. Click Reject. The case transitions to the Rejection stage and the status is set to Pending-
Qualification.
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Exercise: Using the Change Stage smart shape

Scenario
TGB's business policies indicate all expense reimbursement requests are routed to the appropriate
reviewers for approval. If a request for expense reimbursement is rejected by the department
manager or the director, the employee must be provided an opportunity to reconcile the request. After
the employee reconciles the request for expense reimbursement, the request should be automatically
routed back to the Review stage.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Add process steps to the Rejection stage to allow the employee to reconcile the request for expense
reimbursement, and then automatically route the request back to the Review stage.

Detailed steps
Follow these steps to control stage transitions using the Change Stage smart shape.

1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. In the Rejection stage, click + Add process.
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4. Enter Process Rejection as the name of the new process.

5. Select the default step in the Process Rejection process, and then enter Reconcile Expense Report
as the name of the first step.

6. Click + Add step to add another step to the process.

7. In the palette that is displayed, clickMore.

8. Click Utilities to display a list of available smart shapes.

9. Click Change Stage, and then click Select to add the smart shape to the process.

10. In the contextual property panel, select the Select a stage option.
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11. In the Stage drop-down list, select the Review stage.

12. Click Save to save your changes.

Verify your work
Create a new expense report case to test your changes.

1. In the upper right corner of the Case Designer work space, click Run to create a new instance of the
Expense Report case type.

2. On the New: Expense Report screen, click Done to advance to the Enter Expense Details step.

Note: Entering data on this screen is optional.

3. On the Enter Expense Details step, click Complete stage to advance the case to the Review stage.

4. In the Open assignments section, click Please approve or reject this Expense Report to open
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the assignment.

Notice the case is in the Review stage.

5. Click Reject. The case transitions to the Rejection stage, and the status is set to Pending-
Qualification.

6. In the Open assignments panel, click the Process Rejection (Rejection) step.

7. Click Advance this case to advance the case to the Change Stage step.
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The case is returned to the Review stage.
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Sending correspondence

Exercise: Sending correspondence during
case processing

Scenario
TGB's business policies indicate employees must be notified of the status of their requests for expense
reimbursement. Employees must be notified of the manager's decision, the director's decision, and the
result of an audit, when necessary. They must also be notified when the request for expense
reimbursement is received by the accounting department for payment processing, and when the
payment is processed.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Add the necessary steps to the Expense Report case life cycle so that employees are notified as
described in the scenario.

Note: The scenario specifies a total of five correspondences. Each step is configured the same, so you
do not need to configure all five steps. Add at least one step for practice. Then add the other steps if
you want more practice or want to experiment with different configurations.

Detailed steps
Follow these steps to send correspondence.
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1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. In the second stage of the Expense Report case type, click + Add step to add a step to the Review
process.

4. In the palette that is displayed, clickMore.

5. Click Utillities to display a list of available smart shapes.
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6. In the list of available options, scroll down and click Send Email, and then click Select.

7. In the text field of the new step, enter Notify Employee of Status.

8. In the To field in the contextual property panel, enter employeeID@tgb.com.
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9. In the Subject field, enter Expense Voucher status update.

10. In the body of the message, enter Your request for expense reimbursement was approved.

11. Click Save to save your changes.

Test your changes
1. In the upper right corner of the Case Designer work space, click Run to create a new instance of the

Expense Report case type.

2. On the New: Expense Report screen, enter sample data, and then click Done.
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3. On the Enter Expense Details Screen, enter sample data, and then click Submit.

4. In the Open assignments section, click Please approve or reject this expense report.

5. Click Approve.

6. The email appears as an attachment.
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Guiding users through a business
process

Exercise: Adding user guidance to a case type

Scenario
TGB reimburses employees for necessary and reasonable business expenses incurred in the conduct
of TGB's business. TGB wants to ensure business expenses are reported accurately, and reimbursed in
a timely and consistent manner according to company policy.

The goal for this iteration of the Expense Voucher case life cycle is to add directional cues, and set the
relevant status of the case, to help case workers clearly understand the intent of an assignment.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Add instructions for the Enter Expense Details assignment that reads Please provide an itemized list
of expenses, and set the status toNew.

Detailed steps
Follow these steps to add user guidance to a case type.
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1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. Select the Enter Expense Details step.

4. On the General tab of the contextual property panel, place your cursor in the Set status field, and
then press the down arrow key.
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5. Select New from the list of available options.

6. In the Instructions text field, enter Please provide an itemized list of expense items as the
instructions for the assignment.

Important: DO NOT add a period to the end of the instruction.

7. Click Save.

Test your changes
Create a new expense report case to test your changes.

1. In the upper right corner of the Case Designer work space, click Run to create a new instance of the
Expense Report case type.
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2. On the New: Expense Report screen, click Done.

Note: Entering data on this screen is optional.

The instructions and status are displayed on the Enter Expense Details screen.



74
©2017 Pegasystems Inc.

Modeling complex process flows

Exercise: Modeling a complex process flow

Scenario
To ensure expenses are reported accurately, all expense reimbursement requests go through a series
of reviews.

The first review is conducted by the department manager, and is mandatory. If the department
manager approves an expense reimbursement request, the request may require a review by the
director. If a review by the director is required, the request advances to the Director Review process.

After the manger and director reviews are completed — and the request is approved — the request is
evaluated to determine if an audit is required. If the request must be audited, the case is directed to
the alternate Auditing stage. If the request does not require an audit, the case is directed to the
primary Payment stage.

To help ensure reviews are conducted according to company policy, the Manager Review and Director
Review processes should be updated to automate the evaluation of the company policies.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer designer@tgb rules

Your assignment
Update the Manager Review process to incorporate automated decisions for directing the process flow
according to company policies.

Detailed steps
Follow these steps to add automated decision steps to a process flow rule.
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1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to edit the case type.

3. In the Review stage, select the first Review process.

4. From the contextual property panel, click Open process.

5. Right-click on the design canvas and select Add > Decision.

6. On the design canvas, double-click the decision shape to open the properties panel.
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7. In the Decision: field, enter Needs Director review? as the label.

8. Click Submit to close the decision shape's properties panel.

9. Connect the outgoing connector from the Manager Review step the Decision shape.

10. Connect the decision shape to the Notify Employee of status step.

11. Double-click the connector to open the properties panel.

12. In the Connector: field, enter Yes as the label.

13. Click Submit to close the connector's properties panel.

14. Connect the Notify Employee of Status shape to the End shape.
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15. Edit the properties of the End shape and enter Go to Director Review as the label.

16. Add a second decision shape to the design canvas and enter Requires audit? as the label.

17. Connect the Needs Director review? decision shape to the Requires audit? decision shape.

18. Edit the connector properties and enter No as the label.

19. Right-click on the design canvas and select Add > Smart Shapes > Send Email.

20. Edit the properties of the Send Email smart shape and enter Notify Employee of Status as the label.

21. Connect the Requires audit? decision shape to the Notify Employee of Status smart shape.

22. Edit the connector properties and enter Yes as the label.

23. Add a Change Stage smart shape to the design canvass.

24. Edit the properties of the Change Stage smart shape and enter Go to Auditing stage as the label.

25. Connect the Notify Employee of Status smart shape to the Go to Auditing stage smart shape.

26. Add an End shape to the design canvas.
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27. Connect the Go to Auditing stage smart shape to the End shape.

28. Add a Send Email smart shape to the design canvas, and enter Notify Employee of Status as the
label.

29. Connect the Requires audit? decision shape to the Notify Employee of Status smart shape.

30. Edit the connector properties and enter No as the label.

31. Add a Change Stage smart shape to the design canvas, and enter Go to Payment stage as the label.
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32. Connect the Notify Employee of Status smart shape to the Go to Payment stage smart shape.

33. Connect the Go to Payment stage smart shape to the End shape.

34. Click Save.

Verify your work
Create a new Expense Report case to test your changes.

1. In Designer Studio, click Cases to view a list of available case types.

2. In the Case types panel, click Expense Report to open the case type.
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3. In the upper right corner of the Case Designer work space, click Run to create a new instance of the
Expense Report case type.

4. On the New: Expense Report screen, click Done.

Note: Entering data on this screen is optional.

5. On the Enter Expense Details assignment screen, click Submit.

Note: Entering data on this screen is optional

6. On the Expense Report Approval assignment screen, click Approve.

7. From the Choose a connector to take: drop-down list, select Yes.

Note: The flow is running in draft mode, and the decision shapes are not implemented. To
continue advancing a flow that is in draft mode, Pega enables you to manually choose which
connector to take.

8. Click Submit.

The case advances to the Director review process.
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Run the Expense Report case type again. Advance the case and select No from the connector drop-
down list.

The case advances to the Requires audit? decision step.

Optional: Continue testing multiple scenarios.
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Process visibility through business
reporting

Exercise: Modifying a standard report

Scenario
The HR department manager at TGB wants to be able to ensure the application satisfies business
objectives. The business manager wants to create a new report category named HR Reports in which to
organize standard reports customized for their reporting needs. The business manager also wants to
customize the Timeliness by operator and work type for my work group standard report to remove the
workgroup filter.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer manager@tgb rules

Your assignment
Create a new public report category named HR Reports.

Customize the Timeliness by operator and work type for my work group report so that the report does not
filter on a specific work group, and save the modified report to the HR Reports category.

Detailed steps

Add a new report category
1. In the upper-right corner of the Case Manager portal, click Add category.

2. In the Category name field, enter HR Reports.

3. In the Category description field, enter a custom description, or accept the default entry.

4. Click Submit. The HR Reports category is displayed in the Public categories section.

Modify a standard report and save it to a new category
1. In the Public categories section, clickMonitor assignments.

2. In the list of standard reports, click the Timeliness by operator and work type for my workgroup
standard report.

3. From the Actions menu, select Save as. The Save report asmodal dialog window displays.
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4. In the Title field, change the title to Timeliness by operator and work types.

5. From the Category drop-down list, select HR Reports.

6. Click Submit. The report is copied to the HR Reports category and is available for editing.

7. In the Filtered by: section, click the Work group = default@TGB filter condition.

8. From the drop-down list, select is not null.

9. Click Apply Changes.

10. Click Done editing to save your changes to the report.

The report automatically displays available results.
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Assessing Guardrail compliance

Exercise: Assessing guardrails compliance

Scenario
The Lead System Architect on your project has requested that you review the current state of the HR
application, before beginning development of the Onboarding and Benefits enrollment cases.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Review the compliance score for the HR application to establish a base for comparison during
application development. As you develop the Onboarding and Benefits Enrollment case types in the
application, return to the Guardrails landing page to review the readiness of the HR application for
release and compare the readings to the set .

Detailed steps
1. From the Designer Studio menu, select Application > Guardrails. The Guardrails landing page

opens on the Compliance Score tab.
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2. Using the information on the Compliance Score tab, answer the following questions.
a. What is the current compliance score for the HR application?

b. How many rules currently have warnings? Of those rules, how many have unjustified warnings?

c. How many of the rules in the HR application are compliant?

3. Click the Compliance Details tab. The Guardrails landing page switches to the Compliance Details
tab.

4. Using the information on the Compliance Details tab, answer the following questions.
a. How many performance warnings have been introduced into the application?

b. What is the severity of each performance warning?

c. How many maintainability warnings have been generated into the application?

d. What is the severity of each maintainability warning?
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Creating cases and child cases

Exercise: Creating the Onboarding and
Benefit Enrollment case types

Scenario
TGB wants to extend its human resources (HR) application to process onboarding cases for new
employees. These cases guide HR business partners through the onboarding process. This process
includes:

l Collecting basic information about the employee to add to the HR database

l Preparing and emailing a welcome packet to the new employee

l Requesting that the Facilities department prepare a cubicle or office

l Requesting that the IT department prepare a computer with the appropriate software installed

l Allowing the employee to sign up for benefits, including company-sponsored health care

HR requests that you implement the benefits enrollment portion of the onboarding process as a
separate case.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create two new case types: one for onboarding cases, and the other for benefits enrollment cases.
Configure the life cycle of each case to complete the processes that HR must perform. In addition,
configure the Onboarding case type to automatically create a benefits enrollment child case as part of
the onboarding process.

Onboarding
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Benefits Enrollment

Detailed steps

Create the Onboarding case type
Create a case type to describe the onboarding process.
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1. In Designer Studio, open the Cases Explorer.

2. Click Add a case type. The Add case type dialog opens.

3. In the Name field, enter Onboarding.

4. Click Submit. The Add case type dialog closes, and the Onboarding case type now appears in the
Cases Explorer.

Create the Benefits Enrollment case type as a child case for
Onboarding
Create a case type to describe the benefits enrollment process. Create the case type as a child case of
the onboarding process, to make completion of an onboarding case dependent upon completing a
benefits enrollment case.

1. In the Cases Explorer, right-click Onboarding and select Add a child case type. The Add case type
dialog opens.

2. Select New case type.

3. In the Name field Benefits Enrollment.
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4. Click Submit. The Add case type dialog closes and the Benefits Enrollment case type now appears
under the Onboarding case type in the Cases Explorer.

Add stages to the life cycle of the Benefits Enrollment case type
Add stages to describe the life cycle of a benefits enrollment case.

1. In the Case Designer, click Life cycle.

2. Click Add stages. A case life cycle with one stage opens.

3. In the field on the default stage, enter Covered Parties.

4. Click +Add stage. A second stage appears to the right of the first stage.

5. In the field on the second stage, enter Insurance Selection.

6. Click +Add stage. A third stage appears to the right of the second stage.

7. In the field on the third stage, enter Review Selections.
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8. Click Got it. The Stage Properties panel opens.

9. Select the Covered Parties stage.

10. In the properties panel, select Automatically move to the next stage.

11. Select the Insurance Selection stage.

12. In the properties panel, select Automatically move to the next stage.

13. Select the Review Selections stage.

14. In the properties panel, select Resolve the case.

15. Click Save. The case life cycle updates to reflect the current stage configuration.

Add steps to the life cycle for the Benefits Enrollment case type
Add steps to the Benefits Enrollment case type, to represent the tasks and actions performed to
process a benefits enrollment case.

1. In the Case Designer, in the lower right corner, click Add processes?. The Case Designer displays an
image explaining the use of processes in an application.
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2. Click Add processes. The case life cycle appears, with links in each stage to add processes.

3. Under the Covered Parties stage, click + Add process. A process with one step appears under the
Covered parties stage.

4. Click Got it.

5. In the highlighted field, enter Select Participants.

6. Select the first step in the process and enter Confirm Employee Details.

7. Under the Confirm Employee Details step, click + Add step. A pop-up opens to select the type of
step to add.

8. Select Collect Information. A second step with an empty field is added to the process.
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9. In the empty field, enter Identify Dependents.

10. Under the Insurance Selection stage, click + Add process.

11. Repeat steps 5-9 to create a process named Select Insurance Plans with three steps: Select Medical
Coverage, Select Dental Coverage, and Select Vision Coverage.

12. Under the Review Selections stage, click + Add process.

13. Click Save.

Add stages to the life cycle for the Onboarding case type
Add stages to describe the life cycle of an onboarding case.

1. In the Cases Explorer, click Onboarding. The Onboarding case opens in the Case Designer and
displays the Life cycle tab.

2. Click Add stages. A case life cycle with one stage opens.

3. In the field on the default stage, enter Pre-arrival Setup.

4. Click +Add stage. A second stage appears to the right of the first stage.

5. In the field on the second stage, enter Equipment Selection.

6. Click +Add stage. A third stage appears to the right of the second stage.

7. In the field on the third stage, enter Benefits Enrollment.
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8. Click Got it. The Stage Properties panel opens.

9. Select the Pre-arrival setup stage.

10. In the properties panel, select Automatically move to the next stage.

11. Select the Equipment Selection stage.

12. In the properties panel, select Automatically move to the next stage.

13. Select the Benefits Enrollment stage.

14. In the properties panel, select Resolve the case.

15. In the Resolution status field, select Resolved-Completed.

16. Click Save. The case life cycle updates to reflect the current stage configuration.

Add steps to the life cycle for the Onboarding case type
Add steps to the Onboarding case type, to represent the tasks and actions performed to process an
onboarding case.

1. In the Case Designer, in the lower right corner, click Add processes?..

2. Click Add processes. The case life cycle appears, with links in each stage to add processes.

3. Under the Pre-arrival Setup stage, click + Add process. A process with one step appears under the
Pre-arrival Setup stage.

4. Click Got it.

5. In the highlighted field, enter Create Employee Record.

6. Select the first step in the process and enter Collect Employee Info.

7. Position the cursor over the Pre-arrival Setup stage. A down arrow icon appears on the stage to
indicate the Stage menu.

8. From the Stage menu, select Add process. A second process displays in the Pre-arrival Setup stage.

9. Select the new process. In the highlighted field, enter Send Welcome Packet.

10. Select the first step in the process and enter Identify Home Office.
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11. Under the Identify Home Office step, click + Add step. A pop-up opens to select the type of step to
add.

12. Click Collect information. A second step is added to the process.

13. In the empty field, enter Select Orientation Plan.

14. Under the Select Orientation Plan step, click + Add step. A pop-up opens to select the type of step to
add.

15. SelectMore > Utilities > Send Email.

16. Click Select. A third step is added to the process.

17. In the highlighted field, enter Send Welcome Packet.

18. Under the Equipment Selection stage, click + Add process.

19. In the highlighted field, enter Facilities Setup.

20. Select the first step in the process and enter Select Seating Location.

21. Under the Select Seating Location step, click + Add step. A pop-up opens to select the type of step to
add.

22. Select Collect Information.

23. In the empty field, enter Select Office Equipment.

24. Under the Facilities setup step, click + Add step. A pop-up opens to select the type of step to add.

25. Select Approve/Reject.

26. In the Highlighted field, enter Approve Facilities Setup.
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27. Position the cursor over the Equipment selection stage. A down arrow icon appears on the stage to
indicate the Stage menu.

28. From the Stage menu, select Add parallel process. A second process displays in the Equipment
selection stage.

29. In the highlighted field, enter IT Setup.

30. Repeat steps 20-26 to add three steps to the IT Setup process: Select Hardware, Select Software, and
Approve IT Setup.

31. Click Save.



99
©2017 Pegasystems Inc.

Configure the Onboarding case type to create a Benefits Enrollment
child case
Configure an onboarding case to create a benefits enrollment case as a child case. This requires the
user to complete the benefits enrollment case before they can complete the onboarding case.

1. Under the Benefits enrollment stage, click + Add process.

2. Under the Benefits enrollment step, click + Add step. A pop-up opens to select the type of step to
add.

3. SelectMore > Utilities > Create Case(s).

4. Click Select. A second step is added to the process.

5. In the highlighted field, enter Select Benefits.

6. In the properties panel for the Select Benefits step, select Create a child case.

7. From the Case type drop-down field, select Benefits Enrollment.

8. Delete the first step in the process.

9. Click Save.

Run through the onboarding process to verify case behavior
Test the onboarding case to verify the steps added to the case life cycle.
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1. From the +Create menu, select New > Onboarding. The Create view opens.

2. Click Done. The Collect Employee Info form opens.

3. Click Advance this case. The Identify Home Office form opens.

4. Click Advance this case. The Select Orientation Plan form opens.

5. Click Advance this case. The Select Hardware form opens.

6. Click Advance this case. The Select Software form opens.

7. Click Advance this case. The Approval form opens.

8. Click Approve. A confirmation form opens.

9. Under Open Assignments, click Facilities setup (Equipment setup). The Select Seating Location
form opens.

10. Click Advance this case. The Select Office Equipment form opens.

11. Click Advance this case. The Approval form opens.

12. Click Approve. The Confirm Employee Details form for the Benefits Enrollment case opens.

13. Click Advance this case. The Identify Dependents form opens.

14. Click Advance this case. The Select Medical Coverage form opens.

15. Click Advance this case. The Select Dental Coverage form opens.

16. Click Advance this case. The Select Vision Coverage form opens.

17. Click Advance this case. The Review Selections form opens.

18. Click Advance this case. A confirmation form opens to confirm that case processing has
completed.

Skip the Create view when creating an Onboarding case
The default configuration for the Onboarding case type is to present the Create view when the user
creates a case, before the first step in the case life cycle. This form is not used to create an Onboarding
case. Configure the Onboarding case type to skip this form when a user creates an onboarding case.

1. In the Designer Studio, click the Onboarding tab to return to the Onboarding case type in the Case
Designer.

2. In the Case Designer, click the Settings tab.

3. On the Settings tab, click General. The General settings panel opens.

4. Under Behavior, click Skip 'Create' view when users create a new case.
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5. Click Save to commit your changes to the Onboarding case type.
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Data elements in Pega applications

Exercise: Defining the Onboarding and
Benefits Enrollment data models

Scenario
The HR department has identified information needed to process onboarding and benefits enrollment
cases. Both onboarding and benefits enrollment cases must collect information about employees, such
as their employment status, manager, and start date. Benefits enrollment cases must collect
information about an employee's dependents to begin insurance coverage. Onboarding cases must
collect information needed by the Facilities department to assign a seating location in one of TGB's
offices.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create data elements required by the Onboarding and Benefits Enrollment case types. To do this:

l Create the following properties for the Onboarding case type only:
Remote (True/False)

Office (Text)

l Add the following properties to the Employee data type:
Contractor (True/False)

Manager (Text)

Start Date (Date)

l Create a Dependents page list and Dependent data type for the Benefits Enrollment case.

l Create the Relationship property for the Dependent data type with two allowed values:
Spouse/Partner

Child

l Update the Dependent data type to inherit data elements from the standard class Data-Party.

Detailed steps
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Create properties used to describe onboarding cases
1. In the Cases Explorer, click Onboarding. The Onboarding case type opens in the Case Designer.

2. Click the Data model tab.

3. On the Data model tab, click Add field. A row of fields appears on the tab.

4. Under Name, enter Remote employee?.

5. Under ID, enter Remote.

6. From the drop-down list under Type, select Boolean. This completes the definition for the Remote
property.

7. Click Add field.

8. Under Name, enter Office.

9. Click Save to commit your changes to the data model for the Onboarding case type.

Extend the Employee data class with new properties for onboarding
cases
1. In the navigation area, click Data to open the Data Explorer. The Data Explorer displays the set of

data types available to the HRApps application.
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2. In the Data Explorer, click Employee. The work area displays the Employee data type form.

3. On the Data Model tab of the Employee data type, click Add field.

4. In the left-most field, enter Contractor.

5. from the drop-down list, select Boolean.
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6. Click Add field.

7. In the left-most field, enter Manager.

8. From the drop-down list, select Text (Single line).

9. Click Add field.

10. In the left-most field, enter Start Date.

11. From the drop-down list, select Date only.

12. Press the Tab key to exit the drop-down list. The Employee data type form displays the three
properties you created.

Create the Dependents page list and Dependent data class
Create the Dependents page list and Dependent data class to model dependents for benefits
enrollment cases.

1. In the Cases Explorer, click Benefits Enrollment. The Benefits Enrollment case type opens in the
Case Designer.

2. On the Data Model tab, click Add field.

3. Under Name, enter Dependents.

4. From the Type list, select Field group (list). An empty field and New link are displayed under
Options.

5. Click New. A pop-up appears to define the data class.

6. In the pop-up, in the first field enter Dependent.

7. Expand Advanced.

8. In the Parent class field, enter TGB-HRApps-Data.
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9. Click Submit. The pop-up closes and the definition of the Dependents property updates.

Add the Relationship property to the Dependent data class
1. Click Actions and select Refresh. The Case Designer refreshes and returns to the Life cycle tab.

2. Click the Data model tab.

3. In the Options column, click Dependent. The Dependent data type form appears.

4. Click Add field.

5. Under Name, enter Relationship.

6. From the drop-down list under Type, select Picklist.

7. Click the gear icon for the Relationship row. The Edit options pop-up opens.

8. Under List choices, enter Spouse/Partner.

9. Click + Add choice.
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10. Under List choices, enter Child.

11. Click Submit. The Edit options pop-up closes.

Update the inheritance for the Dependent data class
Update the Dependent data class to reference the standard class Data-Party as a parent class for
directed inheritance. This allows the Dependent class to reuse properties defined in the class Data-
Party.

1. In the Navigation area, switch to the Application Explorer.

2. In the Application Explorer, expand BenefitsEnrollment > Data Model > Property.

3. In the Application Explorer, click the Dependents property. The Dependents property record opens.

4. Next to the Page definition field, click the crosshair icon. The Dependent class record opens.

5. Under Class inheritance, in the Parent class (Directed) field, enter Data-Party.

6. Click Save. The Dependent data class now inherits any properties defined for the class Data-Party.
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Setting property values automatically

Exercise: Initializing the list of dependents
for married or partnered employees

Scenario
As part of the benefit enrollment process, employees identify their dependents — family members who
are to be covered by a company-sponsored health plan. If an employee is married or partnered, the
human resources (HR) department wants to automatically add an entry to the list of dependents for
the employee's covered spouse.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Add a list of dependents to the Identify Dependents step of a benefits enrollment case. Allow users to
identify the marital status of a new employee during a benefits enrollment case. If the employee is
married or partnered, add an entry to the list of dependents for the employee's spouse or partner.

To do this:

l Create a Marital Status property in the Benefits Enrollment case. Add to the property a list with two
values: Single and Married/Partnered.

l Add the Marital Status property to the Confirm Employee Details step of the Benefits Enrollment
case life cycle.

l Create a data transform named Initialize Spouse in the Benefits Enrollment class. Configure the
data transform to set the value of the Relationship property in the first row of the Dependents page
list to Spouse/Partner when the employee selects Married/Partnered as the marital status.

l Add the Dependents page list to the Identify Dependents step of the Benefits Enrollment case life
cycle.

l Add the data transform to the Confirm Employee Details connector in the Select Participants
process.

Detailed steps
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Create a property to track marital status for benefits enrollment
cases
Create a property to record the marital status of the employee. Provide two options in a list for the user
to choose from: Single and Married/Partnered.

1. In the Cases Explorer, click Benefits Enrollment. The Benefits Enrollment case type opens in the
Case Designer.

2. Click the Data model tab.

3. Click Add field.

4. Under Name, enter Marital status.

5. From the Type drop-down, select Picklist.

6. Click the gear icon. The Edit options pop-up opens.

7. In the Edit options pop-up, under List Choices, enter Single.

8. Click +Add choice. A second field appears under List Choices.

9. Under List Choices, enter Married/Partnered.

10. Click Submit. The Edit Options pop-up closes.

11. Click Save to commit your changes to the Benefits Enrollment data model.

Add the Marital status property to the Confirm Employee Details form
Add the Marital status property to the UI for the Confirm Employee Details step.

1. In the Case Designer, click the Life cycle tab.

2. Select the Confirm Employee Details step.

3. Click Configure view. The View Configuration dialog opens.
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4. Under Fields, enter or select Marital status.

5. Click Submit. The View Configuration dialog closes.

Initialize the Dependents page list if the employee is married
Configure a data transform to set the value of Relationship in the first row of the Dependents page list
to Spouse/Partner if the employee is married or partnered.

1. In the Application Explorer, expand Benefits Enrollment > Data Model.

2. Under Benefits Enrollment, right-click Data Model and select +Create > Data Transform. The New
Record form appears.

3. In the Label field, enter Initialize spouse.

4. Click Create and open. The Data Transform rule form appears.

5. Under Action, in the drop-down list, selectWhen. A second row appears on the rule form.

6. In the top row, under Target, enter .MaritalStatus == "Married/Partnered".

7. In the second row, under Target, enter or select .Dependents(1).Relationship.

8. Under Source, enter "Spouse/Partner".

9. Click Save.
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Add the Dependents page list to the Identify Dependents step of the
Benefits Enrollment case life cycle
Add the Dependents page list to the Identify Dependents step to test your changes and verify that the
value of Relationship in the first row of the list is set to Spouse/Partner if the employee selects a
marital status of Married/Partnered.

1. Click the Benefits Enrollment tab to return to the Benefits Enrollment case type.

2. In the Case Designer, click the Life cycle tab to display the life cycle for the Benefits Enrollment
case type.

3. Select the Identify Dependents step.

4. Click Configure view. The View Configuration dialog opens.

5. Under Fields, enter or select Dependents.

6. Press Tab to exit the field. A row of fields appears under the Dependents row.

7. Click +Add field to Dependents.

8. In the empty field under Relationship, enter or select First Name.

9. Click +Add field to Dependents.

10. In the empty field under Relationship, enter or select Last Name.

11. Grab the selection handle for the Relationship row, and drag the row below the Last Name row.

12. Click Submit. The View Configuration dialog closes.
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Add the data transform to the Select Participants process
Configure the Select Participants process to run the InitializeSpouse data transform after a user
completes the Confirm Employee Details assignment.

Note: When completing this part of the exercise, be sure to check in any rules that you check out to
edit. This ensures that your exercise environment behaves as expected in later exercises. Failure to
check in any rules that you check out may cause other exercises to return errors.

1. On the Life cycle tab of the Benefits Enrollment case type, select the Select Participants process.

2. Click Open process. The Select Participants flow rule opens.

3. Double-click the connector labeled Confirm Employee Details. The Connector properties panel
opens.

4. In the Connector properties panel, under Set properties, select Apply Data Transform.

5. In the Data transform field, enter or select InitializeSpouse.

6. Click Submit. A clipboard icon appears on the Confirm Employee Details connector.

7. Click Save to save the flow rule.

8. Click the Benefits Enrollment tab to return to the Case Designer.

9. Click Save to save the case type.

Test your changes
Create a benefits enrollment case to test that the relationship listed in the first row of the Dependents
list is set to Spouse/Partner if the user selects a marital status of Married/Partnered.

1. From the Case Designer, click Run. The New: Benefits Enrollment form opens.

2. Click Done. The Collect Employee Details form opens.

3. On the Confirm Employee Details form, from the Marital Status field, selectMarried/Partnered.

4. Click Submit.
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5. On the Identify Dependents form, verify that the Dependents list contains one row, and that in this
row, the drop-down list in the Relationship column has been set to Spouse/Partner.
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Setting property values declaratively

Exercise: Automatically updating the total
cost of benefits

Scenario
During the benefits enrollment process, employees select a medical insurance plan, dental insurance
plan, and vision insurance plan offered by the company. To make affordable choices, employees need
to know the combined cost of their selections. To help employees select affordable options, HR wants
benefits enrollment cases to calculate the total of insurance and display the total during the coverage
selection process.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Add a total cost to each of the coverage selection forms and the Review Selections form. To do this:

l Create a property named "Total benefit cost" to store decimal data.

l Create a page property for each benefit type to record the employee cost of each insurance plan.
MedicalPlan (TGB-HRApps-Data-HRPlan)

DentalPlan (TGB-HRApps-Data-HRPlan)

VisionPlan (TGB-HRApps-Data-HRPlan)

The data class TGB-HRApps-Data-HRPlan has already been created by another system architect.
This data class contains properties to describe insurance plans, including a property to store the
cost paid by the employee for coverage (.EmployeeCost).

l Create a declare expression for the Total benefit cost property to calculate the total benefit cost as
the sum of the employee cost (.EmployeeCost) for each plan.

l Add the Total benefit cost property to the following four assignments in the Benefits Enrollment
case life cycle.

Select Medical Coverage

Select Dental Coverage

Select Vision Coverage

Review Selections

Detailed steps
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Create the Total benefit cost property for benefit enrollment cases
Create a property to store the total cost of benefits selected by the user.

1. In the Cases Explorer, click Benefits Enrollment. The Benefits Enrollment case type opens in the
Case Designer.

2. In the Case Designer, click the Data model tab. The Case Designer displays the data model for the
Benefits Enrollment case type.

3. Click Add field. A new row is added to the list of peroperties.

4. Under Name, in the field enter Total benefit cost.

5. Under Type, from the drop-down list select Currency.

6. Click Save to create the Total benefit cost property for the Benefits Enrollment case type.
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Create page properties for medical, dental, and vision plans to access
the employee cost property for each plan
Create page properties for medical plan, dental plan, and vision plan information. Configure each page
to reference the HRPlans data type. The HRPlans data type contains properties to store information
about insurance plans, including the cost of an insurance plan.

1. On the Data model tab of the Benefits Enrollment case type click Add field. A row of empty fields is
added to the property list.

2. Under Name, in the field enter Medical plan.

3. Under Type, from the drop-down list select Field group. A field and New link are added to the
Options column.

4. Under Options, in the field enter or select TGB-HRApps-Data-HRPlan.

5. Click Add field. A row of empty fields is added to the property list.

6. Under Name, in the field enter Dental plan.

7. Under Type, from the drop-down list select Field group. A field and New link are added to the
Options column.

8. Under Options, in the field enter or select TGB-HRApps-Data-HRPlan.

9. Click Add field. A row of empty fields is added to the property list.

10. Under Name, in the field enter Vision plan.

11. Under Type, from the drop-down list select Field group. A field and New link are added to the
Options column.

12. Under Options, in the field enter or select TGB-HRApps-Data-HRPlan.

13. Click Save to create the Medical plan, Dental plan, and Vision plan pages. These pages reference
the HRPlans data type, which contains a property that stores the value of an insurance coverage
plan.

Create a declare expression rule for the Total benefit cost property
Create a declare expression to calculate the total benefit cost as the sum of the employee cost of the
selected medical plan, dental plan, and vision plan.

1. In Designer Studio, click the Application Explorer.

2. In the Application Explorer, expand Benefits Enrollment > Data Model > Property.
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3. Right-click TotalBenefitCost and select Define Expression. The New Record form appears. If the
TotalBenefitCost property does not appear in the Application Explorer, open the Application
Explorer menu and select Refresh App Explorer.

4. In the Label field, enter Benefit cost calculation.

5. Click Create and open. The Declare Expressions rule form appears.

6. In the field to the right of the Value of drop-down list, enter .MedicalPlan.EmployeeCost +
.DentalPlan.EmployeeCost + .VisionPlan.EmployeeCost.

Note: .EmployeeCost is the property in the TGB-HRApps-Data-HRPlan data class that stores the
value of an insurance coverage plan.

7. Click Save.

Test the declare expression calculation
Test the declare expression to verify that the calculation computes as expected.

1. From the Actionsmenu, select Run. A dialog appears, displaying the Total benefit cost calculation
as a tree structure.
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2. In the expression tree, select the first Employee cost = node. Under the Display section, an
Employee Cost field appears.

3. In the Employee Cost field, enter 50.32.

4. Click Update. The expression tree updates to reflect the entered value.

5. Repeat steps 2-4 for the remaining two nodes. For Employee Cost = values, enter 31.30 and 17.50.



120
©2017 Pegasystems Inc.

Add the Total benefit cost property to each of the insurance selection
forms and the Review Selections form
Add the total benefit cost to the Select Medical Coverage, Select Dental Coverage, Select Vision
Coverage, and Review Selections forms. This displays the total cost of the benefits selected by the user
on each form.

1. In the Case Designer, open the Benefits Enrollment case.

2. On the Benefits Enrollment case, click the Life cycle tab to return to the benefits enrollment case life
cycle.

3. In the In the Insurance selection stage, select the Select Medical Coverage step.

4. In the properties panel for the step, click Configure view. The View Configuration dialog appears.

5. On the Fields tab, in the leftmost field, enter or select Total benefit cost.

6. Press Tab to exit the field. The contents of the form update to reflect the property details.

7. Click Submit. The View Configuration dialog closes.

8. Repeat steps 3-7 for the remaining two insurance selection forms, and for the Review Selections
form.

9. Click Save to commit your changes to the Benefits Enrollment case type.

Test your changes
Create a benefits enrollment case to test your configuration.

1. Create a benefits enrollment case.

2. Verify that the Total benefit cost property appears on each of the insurance selection forms and the
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Review Selections form.

Note: The .TotalBenefitCost property is calculated and displays read-only, so no field appears on any of
the forms. Since the value of the property is defined as the sum of three properties that also do not
appear on any forms, no value is calculated for the total benefit cost. In an upcoming exercise, you
address this issue by adding fields for the insurance plan information to each form.
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Passing data to another case

Exercise: Passing data to another case

Scenario
The human resources (HR) department needs to reduce their data entry work. The HR manager is
requesting that the candidate data from the onboarding forms automatically populate the benefits
enrollment form.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Configure the onboarding case type to automatically copy employee data to the benefits enrollment
child case when creating the benefits enrollment case.

Add fields to the Collect Employee Info form to allow users to enter values for the properties on the
Employee page.

Detailed steps
1. Open the Case Explorer.

2. Select the Onboarding case type.

3. Open the Settings tab.

4. On the Settings tab, click Data propagation.

5. Expand the Into Benefits Enrollment area.

6. Under Into Benefits Enrollment, click the Add property link. A pop-up appears to allow you to
configure data propagation from the onboarding case to a benefits enrollment case.

7. In the pop-up, under Propagate property value, enter or select Employee.

8. Under To property value, enter or select Employee.

9. Click OK to dismiss the pop-up.

10. Click Save to commit your changes to the data propagation configuration for the Onboarding case
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type.

Configure the Collect Employee Info form to collect properties needed
for data propagation
Add properties to the Collect Employee Info form to collect the data to copy from an onboarding case to
a benefits enrollment case.

1. On the Onboarding tab in the Case Designer, click the Life cycle tab.

2. In the Onboarding case life cycle, click the Collect Employee Info step.

3. Click Configure View. The View Configuration dialog opens.

4. In the empty text box under Fields, enter or select Employee.

5. Press the Tab key. A set of fields appears under Employee.
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Note: If Pega does not display the set of fields under Employee, skip to step 14 and add the fields
shown in the screenshot.

6. Hover over the selection rectangle for the Start date field, then press the mouse button to select
the field.

7. Drag the mouse cursor under the Contractor field, then release the mouse button.

8. Select the selection rectangle for the First name field and drag the field below the Start date field.

9. Select the selection rectangle for the Last name field and drag the field below the First name field.

10. Select the selection rectangle for the Email field and drag the field below the Last name field.
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11. To the right of the Department row, click the Delete icon. The row is removed from the list of fields.

12. To the right of the Employee ID row, click the Delete icon. The row is removed from the list of fields.

13. To the right of the HR Business Partner row, click the Delete icon. The row is removed from the list
of fields.

14. To the right of the SSN row, click the Delete icon. The row is removed from the list of fields.
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15. Click Submit. The View Configuration dialog closes.

16. Click Save to commit your changes to the Onboarding case type.

Note: The benefits enrollment case type is not configured to display employee information, so you
cannot verify your changes solely by creating and processing an onboarding case. The next lesson
covers how to view case data that is not displayed on a form by using the Clipboard tool.
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Reviewing application data

Exercise: Reviewing case data on the
clipboard

Scenario
You have configured data propagation for the onboarding case to copy employee information to the
benefits enrollment case. To verify that the benefits enrollment case contains the correct information,
your manager has asked you to go through the onboarding process and verify that the data
propagation works as expected.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Review case data on the clipboard to ensure that the data propagation you configured works as
expected. To do this:

l Create an onboarding case, and provide employee information on the Collect Employee Info form.

l Continue through the Onboarding process to create a benefits enrollment case.

l After you create the benefits enrollment case, use the Clipboard tool to verify that data on the
Employee page for the Benefits Enrollment case matches your entries on the Collect Employee Info
form.

Detailed steps
Create an onboarding case, and verify that the contents of the Employee page are copied to the
benefits enrollment case when the case is created.

1. From the +Create menu, select New > Onboarding to create a new onboarding case.

2. On the Collect Employee Info form, enter data into each of the fields using the information in the
following example.



128
©2017 Pegasystems Inc.

3. Click Submit to advance to the Identify Home Office form.

4. Click Submit to advance to the Select Orientation Plan form.

5. Click Submit to advance to the Select Hardware form.

6. Click Advance this case to advance to the Select Software form.

7. Click Advance this case. A confirmation form is displayed to inform you that the case has been
routed for approval.

8. Under Open assignments, click Please approve or reject this Approval to advance to the Approval
form.

9. Click Approve. A confirmation form is displayed.

10. Under Open Assignments, click Facilities Setup (Equipment Selection) to advance to the Select
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Seating Location form.

11. Click Submit to advance to the Select Office Equipment form.

12. Click Advance this case. A confirmation form is displayed to inform you that the case has been
routed for approval.

13. Under Open assignments, click Facilities Setup (Equipment Selection) to advance to the Approval
form.

14. Click Approve to advance to the Confirm Employee Details form for the benefits enrollment child
case.

15. On the Developer toolbar, click Clipboard. The Clipboard tool opens in a new window.

16. In the left pane of the Clipboard tool, in the User Pages section expand pyWorkPage.

17. Under pyWorkPage, select Employee (TGB-HRApps-Data-Employee). The contents of the Employee
page are displayed in the right pane of the Clipboard tool.
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18. Verify that the contents of the Employee page match the values you entered in step 2.
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Configuring a work party

Exercise: Creating an employee work party

Scenario
The human resources (HR) department sends each new employee a welcome email as part of the
onboarding process. To address this email, you must add the employee to the onboarding case as a
work party.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Add the new employee to an onboarding case as a party to the case, and populate the work party with
employee information from the Create Employee Info form. To do this:

l Define the Employee work party on the work parties rule for the Onboarding case.

l Create a data transform named EmployeeParty to populate the work party with identifying
information.

l Configure the Create Employee Record process to call the addWorkObjectParty API activity and add
the Employee work party to the Onboarding case.

Detailed steps

Create the Employee party in the pyCaseManagementDefault work
parties rule
Create a work party to represent the employee in an onboarding case.

1. In the Application Explorer, expand Onboarding > Process > Work Parties.

2. Click pyCaseManagementDefault. The pyCaseManagementDefault work parties rule opens.

3. In the "List of valid parties" section of the rule form, click the Add a row icon.

4. In the new row, under Party Name, enter Employee.

5. Under Party Class, select or enter TGB-HRApps-Data-Employee.

6. Under Party Prompt, enter New hire.
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7. Under Data Transform, enter EmployeeParty.

Create the EmployeeParty data transform to copy data to the work
party
Create a data transform to copy property values from the onboarding case to the Employee work party,

1. Click the crosshair icon to the right of the Data Transform field to create the EmployeeParty data
transform. The New Record form opens.

2. In the New Record form, click Create and open to create the data transform. The Data Transform
rule form opens.

3. In the first row of the data transform, under Target, enter or select .pxPartyRole.

4. Under Source, enter "Employee".

5. Click the Add a row icon to create three additional rows.

6. Complete each empty row on the data transform using the values in the following table.

Action Target Source
Set .pyEmail1 pyWorkPage.Employee.Email
Set .pyFirstName pyWorkPage.Employee.FirstName
Set .pyLastName pyWorkPage.Employee.LastName

7. Click Save to save the data transform. Note the errors that occur.



134
©2017 Pegasystems Inc.

Note: These errors occur because the context of the source properties is unknown. To resolve this
issue, add a reference for pyWorkPage on the Pages & Classes tab of the data transform.

8. Click the Pages & Classes tab to specify the class for the page pyWorkPage.

9. Under Page name, enter pyWorkPage.

10. Under Class, enter or select TGB-HRApps-Work-Onboarding.

11. On the data transform rule form, click the Definition tab.

12. Click Save to save the data transform. Note that the data transform saves with no errors.

13. Return to the pyCaseManagementDefaults work parties rule.

14. Click Save.

Add the addWorkObjectParty activity to the Create Employee Record
process
Add the API activity addWorkObjectParty to the Create Employee Record process to create the Employee
work party automatically.

1. In the Case Designer, select the Create Employee Record process, then click Open Process.

2. Add a utility shape to the process, after the Collect Employee Info assignment.
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3. Double-click the utility shape to open the Properties panel.

4. In the Utility field, enter Create Employee Work Party.

5. In the Rule field, enter addWorkObjectParty.

6. Press the Tab key to add the activity parameters to the Properties panel.

7. In the PartyRole field, enter Employee to add the Employee work party to the case.

8. In the PartyClass field, enter TGB-HRApps-Data-Employee.

9. In the PartyModel field, enter EmployeeParty.
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10. Click Submit to close the Properties panel.

11. Click Save to save the flow.

Note: Model is an older name for a data transform rule.

Test your changes
Create a new onboarding case to confirm that the Employee work party is created automatically after
the user completes the Collect Employee Info assignment.

1. From the Create menu, select New > Onboarding.

2. Complete the Collect Employee Info form.

3. Click Submit to submit the form. The Identify Home Office form opens.

4. In the Participants section, verify that the application created the Employee party.

5. On the Developer toolbar, click Clipboard. The Clipboard tool opens.

6. In the Clipboard tool, under User Pages, expand pyWorkPage > pyWorkParty.

7. Select pyWorkParty(Employee) and verify that the information you entered on the Collect
Employee Info form was added to the Employee work party.

Note: The Employee work party includes information you did not copy with your data transform. Pega
automatically adds additional information to the work party by using rules defined in the Data-Party
class.
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Configuring a service level agreement

Exercise: Establish a service level agreement
for the Select Orientation Plan assignment

Scenario
As part of the onboarding process, managers must identify an orientation plan for each new employee.
During the onboarding process, HR selects one or more orientation courses for the employee. To
ensure that HR can enroll the new employee in the selected courses, the orientation plan for an
employee must be completed within two days, and preferably within one day. If the HR partner
assigned to the onboarding case fails to complete the assignment within two days, a reminder email is
sent to the HR partner every day until the assignment is completed.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Add a service level agreement to the Select Orientation Plan assignment of the Onboarding case type.
Configure the service level agreement to remind HR partners to select orientation courses for the
employee in a timely manner by configuring:

l A goal interval of one day.

l A deadline of two days.

l A repeating action for late assignments to send a reminder email to the HR partner.

Detailed steps
Configure a service level agreement for the Select Orientation Plan assignment. For this service level
agreement:

l Configure an initial urgency of 20.

l Configure a goal interval of one day, with an urgency of 10.

l Configure a deadline interval of two days, with an urgency of 10.

l Configure a passed deadline interval of one day, with an urgency of 10 and no limit on the number
of events.

l Add an escalation action to notify the assignee upon completion of each passed deadline interval.
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Create the service level agreement for the Select Orientation Plan
1. In the Cases Explorer, select Onboarding. The Onboarding case type opens in the Case Designer.

2. In the Pre-arrival stage of the Benefits Enrollment case life cycle, click the Select Orientation Plan
step. The properties panel for the step opens to the right of the case life cycle.

3. In the properties panel, click the Goal & deadline tab.

4. Select the Consider goal and deadline check box. The properties panel updates to display goal
and deadline configuration options.

5. From the Service level agreement drop-down list, select Use existing. An empty field is displayed
below the drop-down list.

6. In the empty field, enter SelectOrientationPlan.

7. Click the crosshair icon to the right of the field. The New Record form opens.

8. Click Create and open. The Service Level Agreement rule form opens.

Configure intervals and urgency adjustments for the service level
agreement
1. In the Inital Urgency field, enter 20.

2. In the Goal section, under Days, enter 1.

3. Under Amount to increase urgency, enter 10.
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4. In the Deadline section, under Days enter 2.

5. Under Amount to increase urgency, enter 10.

6. In the Passed Deadline section, clear the contents of the Limit passed deadline events to field.

7. Under Days, enter 1.

8. Under Amount to increase urgency, enter 10.

9. Under Actions, click Select Action. The Perform Action drop-down list is displayed for the Passed
Deadline interval.

10. From the Perform Action drop-down list, select Notify Assignee.

11. Click Save.
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12. In Designer Studio, click the Onboarding tab. Designer Studio returns to the case life cycle for the
Onboarding case.

13. Click Save.

Test your changes
1. From the +Create menu, select New > Onboarding. The Collect Employee Info form opens.

2. Click Submit. The onboarding case advances to the Identify Home Office form.

3. Click Submit. The onboarding case advances to the Select Orientation Plan form. The time
remaining in the goal interval is indicated on a green background. The time remaining in the
deadline interval is indicated to the right of the user name.
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Routing assignments

Exercise: Routing an assignment

Scenario
Currently, all IT requests route to the requestor's manager for approval. Management decided that the
IT department is better qualified to analyze IT requests. The organization decided that users in the
IT workgroup are better qualified to analyze IT requests. All IT requests will go to the IT workbasket
(IT@TGB). IT members can access the requests in this workbasket.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Update the application to ensure that IT requests route to the IT workgroup (IT@TGB), rather than to
the operator's reporting manager.

To support the requirement, route assignments to the IT@TGB workbasket in the Approve IT Setup
approval flow. Specify the IT@TGB workbasket in the Approve IT Setup approval flow router setting.

Detailed steps
To update the router setting in the Approve IT Setup, follow these steps:

1. From the Onboarding case life cycle, open the IT Setup process.

2. Right-click the Approve IT Setup SmartShape.

3. Select View Properties.

4.  In the Approve IT Setup properties panel, do the following:

a. In the Approval to be completed by field, select Work Basket.
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b. In the autocomplete field, under the Approval to be completed label, select IT@TGB.

5. In the property panel, click Submit.

6. Save the IT Setup flow.
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Configuring correspondence

Exercise: Sending a welcome email to new
employees

Scenario
As part of the onboarding process, TGB sends each new employee a welcome email. This email
contains the start date, manager, and home office for the employee. The email also provides
information about paperwork that the employee must bring on the first day.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create the welcome email to send to new employees during the onboarding process.

Detailed steps
To accomplish this task, create a correspondence rule named WelcomeEmail. The WelcomeEmail
correspondence rule contains the content of the email. Add to the welcome message references for the
following properties:

l First name (.Employee.FirstName)

l Office (.Office)

l Start date (.Employee.StartDate)

l Manager (.Employee.Manager)

Then, reference the WelcomeEmail correspondence rule on the Send Welcome Email step in the
Onboarding case life cycle. For a recipient, use the Employee work party you created in a previous
exercise.

Finally, use the Case Designer to add the Office property to the Identify Home Office step.

Note: Your exercise environment is not configured to send email correspondence. During this
exercise, you may notice that the attached email indicates an exception error. This exception results
from the application being unable to send the email in the exercise environment. You can ignore this
error.

Create the WelcomeEmail correspondence rule
Create the correspondence rule to send as an email.
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1. In the Application Explorer, expand Onboarding.

2. Right-click Process and select +Create > Correspondence. The New Record form opens.

3. In the Label field, enter Welcome email.

4. In the Correspondence Type field, press the down arrow and select Email.

5. Click Create and open. The Correspondence rule form opens.

Create the contents of the Welcome email
Enter the contents of the email on the correspondence rule form. Add property references to
customize the email with details from the onboarding case.

1. In the Correspondence rule form editor, enter the following text:

Dear FirstName,

Welcome to TGB. As discussed in our previous conversation, your first day at TGB will be StartDate.

On your first day, please arrive at Reception in our Office office no later than 9AM. You will be
greeted by your manager, Manager, who will escort you to your orientation session. You will attend
New Hire Orientation for your first week at TGB.

Please bring two forms of identification, as specified in the attached document, and a completed copy
of the attached W-2 form.

Welcome to TGB!

Note: FirstName, StartDate, Office, and Manager are placeholders for property references. Enter
these placeholders for now, to indicate where to insert property references in upcoming steps.

2. Select the text FirstName in the text of the email.

3. Click the Insert Property button on the editor toolbar. The Property Parameters dialog opens.
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4. In the Name field, enter .Employee.FirstName.

5. Click Save. The Property Parameters dialog closes, and a reference for the First Name property is
displayed in the email text.

6. Repeat steps 2-5 to replace the text StartDate, Office, and Manager with property references, as
outlined in the following table.

Text Property Reference
StartDate .Employee.StartDate

Office .Office

Manager .Employee.Manager

7. Click Save. Your form will look like the following example:
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Configure the Onboarding case type to send the welcome email
Configure the Onboarding case type to send the welcome email to the Employee party at the Send
Welcome Packet step.

1. In the Cases Explorer, click Onboarding. The Onboarding case opens in the Case Designer.

2. In the Send Welcome Packet flow, select the Send Welcome Email step. The properties panel for
the Send Email utility shape opens to the right of the case life cycle.

3. Under Send to, select Party. The properties panel updates to display a Parties field.

4. In the Parties field, enter or select Employee.

5. In the Subject field, enter Welcome.
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6. Under Message, select Correspondence. The properties panel updates to display the
Correspondence template field.

7. In the Correspondence template field, enter WelcomeEmail.

8. Click Save to update the Onboarding case type to send the WelcomeEmail email.

Add the Office property to a form
Add the Office property to the Identify Home Office form to allow users to enter an office. The value
that users enter in this field is used to customize the correspondence to the new employee.

1. In the Case Designer, select the Identify Home Office step. The properties panel for the Identify
Home Office step opens to the right of the case life cycle,

2. In the properties panel, click Configure view. The View configuration dialog opens.

3. In the View configuration dialog, under Fields enter or select Office.

4. Click Submit. The View configuration dialog closes.

5. In the Case Designer, click Save to commit your changes to the Onboarding case type.

Test your changes
1. Create a new Onboarding case.

2. On the Collect Employee Info form, enter data in the fields as shown in the following example.
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3. Click Submit. The case advances to the Identify Home Office form.

4. On the Identify Home Office form, in the Office field, enter Berlin.

5. Click Submit. The case advances to the Select Orientation Plan form.

6. Click Submit. Under Attachments, the email generated by the application is listed.

7. ClickWelcome to open the email attachment.

8. Verify that the content matches the rule and the data you entered on previous forms in the case.
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9. Close the Onboarding case.
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Circumstancing rules

Exercise: Circumstancing the welcome email
for contract employees

Scenario
TGB sends a welcome email to both full-time and contract employees. Unlike full-time employees,
contractors have a shorter orientation period — one day — and must provide different paperwork on
their first day. You must customize the email sent to contractors to reflect these differences.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Customize a version of the welcome email to send to contract employees to mention that orientation
lasts one day, and that the employee must provide a completed copy of the Contract Employee
Agreement on their first day of work.

To do this, create a circumstanced version of the WelcomeEmail correspondence rule. For a
circumstancing condition, test whether the value of the Contract employee property
(.Employee.Contractor) is true.

Detailed steps

Create a circumstanced version of the WelcomeEmail correspondence
rule
1. In the Application Explorer, expand Onboarding > Process > Correspondence, then select

WelcomeEmail to open the welcome email.

2. Click the pull-down menu on the Save as button, and select Specialize as circumstance.

3. On the Specialize Correspondence form, select Property and Date.
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4. In the Property field, select or enter .Employee.Contractor.

5. In the Value field, enter true.

6. Click Create and open. The Correspondence rule form opens.

Define the behavior for the circumstance
1. Update the text of the email to read:

Dear <<.Employee.FirstName>> ,

Welcome to TGB. As discussed in our previous conversation, your first day at TGB will be
<<.Employee.StartDate>> .

On your first day, please arrive at Reception in our <<.Office>> office no later than 9AM. You will be
greeted by your manager, <<.Employee.Manager>> , who will escort you to your orientation session.
You will attend New Hire Orientation for your first day at TGB.

Please bring two forms of identification as specified in the attached document, and a completed copy
of the attached Contract Employee Agreement.

Welcome to TGB!

2. Click Save.

Test your changes by creating a new onboarding case
1. From the Create menu, select New > Onboarding case.

2. On the Collect Employee Info form, select Contractor, then complete the remaining fields on the
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form.

3. Click Submit. The case advances to the Identify Home Office form.

4. On the Identify Home Office form, in the Office field, enter Berlin.

5. Click Submit. The case advances to the Select Orientation Plan form.

6. On the Select Orientation Plan form, click Submit.

7. Open the attached email and verify that the content matches the circumstanced version of the rule.
The attached email should mention that the recipient attends New Hire Orientation for their first
day, and that the recipient should bring a completed copy of the Contract Employee Agreement.
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8. Close the onboarding case.
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Configuring when rules

Exercise: Skipping facilities setup for remote
employees

Scenario
TGB hires remote employees — employees who do not work in one of the five main TGB offices. The
onboarding process for remote employees does not require selecting a seating location or requesting
office equipment such as a desk or telephone.

The HR department indicates that for these remote employees, onboarding cases skip the Facilities
Setup process.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Identify onboarding cases for remote employees, and skip the Facilities setup for these cases.

You can create a When rule to test the value of the .Remote property, and return a true value if the
value of the property is "false". Then, use this When rule as a Start when condition on the Facilities
Setup process.

Detailed steps

Create a when rule to identify remote employees
1. Open the Onboarding case type in the Case Designer.

2. Select the Facilities Setup process.

3. In the Process panel, under Start when, enter IsNotRemote, then click the crosshair icon next to
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the field.

Note: Tip: Name When rules to identify the condition that returns a true result. The Facilities Setup
process runs only if the employee is not considered remote.

4. On the New Rule form, click Create and open. A new When rule form opens.

Define the condition to test if an employee is remote
1. On the Conditions tab of the When rule form, double-click the text [Double click to add

condition]. The Condition dialog opens.

2. In the Condition dialog, in the leftmost field, select or enter .Remote.

3. In the rightmost field, enter "false".
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4. Click Submit. The Condition dialog closes.

5. Click Save to commit your change to the when rule.

Add a check box for the Remote property to the Identify Home Office
form
1. Return to the Case Designer.

2. Select the Identify Home Office step.

3. Click Configure view. The View Configuration dialog appears.

4. Click Add field. A row of empty fields is added to the dialog.

5. Under Fields, select the Remote property, which you created in a previous exercise.

Note: Confirm that you add the property named Remote, as shown in the following screenshot,
rather than creating a new property.
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6. Click Submit to save your changes to the form. The View Configuration dialog closes.

7. Click Save to commit your changes to the Onboarding case type.

Test your changes
1. Create a new onboarding case.

2. On the Identify Home Office form, click the Remote Employee? check box.

3. Continue to the Equipment Selection stage, and verify that the Facilities Setup process does not run.
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Configuring decision tables and
decision trees

Exercise: Configuring a decision table to
route Facilities requests

Scenario
During the onboarding process, the Facilities department must set up a workstation for on-site
employees. To avoid delays in the onboarding process, HR wants to ensure that each Facilities request
is routed to the correct local office of the Facilities department.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create a decision table to route a Facilities request to the appropriate workbasket, based upon the
home office specified for the employee.

Detailed steps
Configure a decision table to route the Facilities request to one of the five workbaskets configured for
the Facilities department:

l Facilities_ATL@TGB (Atlanta home office)

l Facilities_BER@TGB (Berlin home office)

l Facilities_LON@TGB (London home office)

l Facilities_TOK@TGB (Tokyo home office)

l Facilities_VAN@TGB (Vancouver home office)

Replace the Approve Facilities Setup approval shape with an assignment of the same name — the
Approve/Reject step does not support the router you need to use. Configure the assignment to use the
ToDecisionTable router, and select the decision table you create as the parameter passed to the router.
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Create a decision table for routing cases to the correct Facilities
workbasket
Create a decision table to automate the routing logic for Facilities requests.

1. Open the Application Explorer.

2. Expand Onboarding > Decision.

3. Right-click Decision and select +Create > Decision Table. The New Record form opens.

4. In the Label field, enter Facilities routing.

5. Click Create and open. The decision table rule form opens.

Configure the decision table to return a workbasket based on the
selected home office
Configure the decision table to return the name of the workbasket that corresponds to each TGB office.

1. Under Conditions, click the empty header cell. The Decision Table property chooser dialog opens.

2. In the Property field, enter or select .Office.

3. Click Save. The Decision Table property chooser dialog closes, returning you to the decision table
rule form.

4. Under Conditions, click the empty cell and enter "Atlanta".

5. Under Actions, click the empty cell next to the cell containing "Atlanta" and enter "Facilities_
ATL@TGB".

6. In the empty cell in the otherwise row, enter "Facilities@TGB".

7. Click the Insert row before icon four times to create four rows in the decision table for the
remaining TGB offices.

8. Enter information in the remaining rows according to the following table.

Conditions Actions
"Berlin" "Facilities_BER@TGB"
"London" "Facilities_LON@TGB"
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"Tokyo" "Facilities_TOK@TGB"
"Vancouver" "Facilities_VAN@TGB"

9. Click Save. The completed decision table should match the following screenshot.

Replace the Facilities Approval step with an assignment named
Facilities Review
Replace the Approve Facilities Setup approval shape with an assignment of the same name — the
Approve/Reject step does not support the router you need to use.

1. Open the Cases Explorer.

2. In the Cases Explorer, click Onboarding. The Onboarding case type opens in the Case Designer.

3. Select the Facilities Setup process. The Process properties panel opens to the right of the case life
cycle.

4. In the Process properties panel, click Open process. The Facilities Setup flow rule opens.

5. From the Flow Shapes menu, select Assignment and drag an assignment onto the flow editor.

6. Reposition the Select Office Equipment connector so it connects to the assignment you just added
to the flow.
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7. Add a connector from the assignment to the end shape.

8. Delete the Facilities Approval shape and the connector leading from the Facilities Approval shape to
the end shape.

9. Right-click the assignment shape you added, and select View Properties. The Assignment
Properties dialog opens.

10. In the Assignment field, enter Facilities Review.

11. Click Submit.

12. Right-click the connector between the Facilities Review assignment and the end shape, and select
View Properties. The Connector Properties dialog opens.

13. In the Connector field, enter Approval.

14. In the Flow Action field, enter or select pyApproval.

Note: In Pega, a flow action record describes an action that a user can perform to complete an
assignment. The pyApproval flow action is a standard action for approving a case. Flow actions are
discussed in the lesson Designing a UI form.

15. Click Submit.

16. Click Save to commit your changes to the process.

17. Close the Facilities Setup flow rule. The Designer Studio returns to the Case Designer.

18. From the Actionsmenu, select Refresh. The life cycle for the Onboarding case type updates to
reflect your changes to the Facilities Setup flow rule.
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Configure the Facilities Review assignment to use the
ToDecisionTable router
Configure the Facilities Review assignment to use the ToDecisionTable router. Select the decision table
you create as the parameter passed to the router.

1. In the Case Designer, select the Facilities Review assignment. The Assignment Properties panel
opens on the right side of the Case Designer.

2. Under Route to, select Custom.

3. From the Assignment type drop-down list, selectWork queue.

4. In the Router field, enter or select ToDecisionTable. An expanded Parameters section is added to
the Assignment Properties panel.

5. Under Parameters, in the DecisionTable field, enter or select FacilitiesRouting.

6. Click Save to commit your changes to the Onboarding case type.
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Test your changes
1. Create a new Onboarding case.

2. Complete the Collect Employee Info form.

3. Click Submit. The Identify Home Office form appears.

4. In the Office field, enter one of the five valid home office locations: Atlanta, Berlin, London, Tokyo, or
Vancouver.

Note: If you do not enter one of the five valid office locations, Pega returns an error on the Facilities
Review form.

5. Click Submit.

6. Continue to the Facilities Review form.

7. Verify that the Facilities Review assignment was routed to the workbasket that corresponds to the
home office you entered in step 4.

Home Office Workbasket
Atlanta Facilities_ATL@TGB
Berlin Facilities_BER@TGB
London Facilities_LON@TGB
Tokyo Facilities_TOK@TGB
Vancouver Facilities_VAN@TGB

Note: If you do not enter a home office in step 4, Pega returns an error on the Facilities Review
assignment. This error occurs because the routing activity does not process the otherwise result. You
can address this problem by preventing the user from submitting the form until they select a home
office. The lesson Validating user data presents two approaches to resolving this error.
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Designing a UI form

Exercise: Configuring Onboarding and
Benefits Enrollment UI forms

Scenario
Now that the data model and business process for the Onboarding and Benefits Enrollment case types
are mostly complete, you have begun attending Grooming/Elaboration sessions to design the UI for
these case types. You have been asked to configure the UI for the Select Seating Location and Select
Orientation Plan forms in the Onboarding case type. You have also been asked to update the Review
Selections form for the Benefits Enrollment case type.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create a reusable Employee Information section containing the following properties:

l First Name

l Last Name

l Manager

l Start date

Create the Select Seating Location form with the following two properties, then add the Employee
Information section to the form:

l Office, as a read-only text field

l Location, as a drop-down list

Create a page list property named Courses for enablement courses. Update the Select Orientation Plan
form with a list of course data, then add the Employee Information section to the form.

Update the property definition for the Courses page list property to reference a data page containing
data about the enablement courses.

Update the form for the Review Selections assignment in the Benefits Enrollment case type to add the
Employee Information, Confirm Employee Details, and Identify Dependents sections.
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Note: In this exercise, you update forms that were created by using the Case Designer. When the Case
Designer creates a section rule, the suffix "_0" is appended to the name of the section. This allows you
to differentiate between sections created by the Case Designer and sections created by system
architects.

Detailed steps

Create the Select Seating Location form
Create the Select Seating Location form with two properties:

l Office, as a read-only text field

l Location, as a drop-down list

1. In the Cases Explorer, click the Onboarding case. The Onboarding case type opens in the Case
Designer.

2. Click the Select Seating Location step. The properties panel for the step opens to the right of the
case life cycle.

3. Click Configure view. The View Configuration dialog opens.

4. In the View configuration dialog, under Fields, enter or select Office. The Office field is added to the
Select Seating Location form.

5. From the right-most drop-down list, select Read-only.

6. Click + Add field. A second row of fields is added to the dialog.

7. In the field labeled Enter field here ..., enter Location.

8. From the drop-down list labeled Text (single line), select Picklist.
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9. Click Submit. The View Configuration dialog closes.

10. Click Save to commit your changes to the Onboarding case type.

Update the Select Orientation Plan form
Update the Select Orientation Plan form to add a repeating list to display course data and remove the
Manager field from the form.

1. In the Case Designer, click the Data model tab.

2. On the Data model tab, click Add field. A row of fields displays on the tab.

3. Under Name, enter Courses.

4. From the Type list, select Field group (list). An empty field and a New link are displayed under
Options.

5. Under Options, enter or select Courses to reference the Courses data class.

6. Click Save to create the Courses page list property.

7. Click the Life cycle tab. The Case Designer displays the life cycle for the Onboarding case type.

8. In the Case Designer, click the Select Orientation Plan step. The properties panel for the step
opens to the right of the case life cycle.

9. Click Configure View. The View configuration dialog opens.

10. In the View configuration dialog, under Fields, enter Courses.

11. Press Tab to exit the field. The View Configuration dialog updates to display the properties defined
for the Courses page list property.

12. From the drop-down list to the right of the field containing the field name, select Field group (list).
The View Configuration dialog updates to display the properties defined for the Courses page list
property.
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13. Click and hold the selection handle for the ID property.

14. Drag the cursor above the Description property, then release the mouse button to reorder the
properties in the list.
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15. Use the selection handle for the Title property to move the Title property above the Description
property.

16. Use the selection handle for the Selection flag property to move the property above the ID property.

17. Click Submit. The View configuration dialog closes.

18. Click Save to commit your changes to the Onboarding case type.
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Update the Courses property to copy data from the data page
containing course information
Update the Courses property to automatically populate data from a data page that caches course data.

1. In Designer Studio, open the Application Explorer.

2. Expand Onboarding > Data Model > Property and click Courses. The Courses property rule
opens.

3. Under Data access, select Copy data from a data page. The Courses rule form updates.

4. In the Data Page field, enter or select D_CoursesList to populate the Courses page list with course
data from the data page.
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5. Click Save to commit your changes to populate the Select Orientation Plan form with course data.

Create a reusable Employee Info section
Create a reusable Employee Info section that contains the following properties arranged in two
columns.

l First Name

l Last Name

l Manager

l Start date

1. In the Application Explorer, use the application scoping control to select TGB-HRApps-Data-
Employee. The Application Explorer updates to display the contents of the TGB-HRApps-Data-
Employeeclass.

2. Right-click TGB-HRApps-Data-Employee and select Create > User Interface > Section. The New
Record form opens.

3. In the Label field, enter Employee information.

4. Click Create and open. The Employee information section rule opens.

5. In the Application Explorer, expand Data Model > Property.
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6. Click and hold the selection handle for the FirstName property.

7. Drag the cursor into the existing layout, then release the mouse button. A text input control labeled
First name is added to the layout.

8. For the LastName, Manager, and StartDate properties, click the selection handle and drag the cursor
from the Application Explorer to the dynamic layout.

9. Click the header for the Dynamic Layout (Default) layout. A gear icon is displayed on the header.

10. Click the gear icon. The Dynamic Layout properties panel opens.

11. From the Layout Format drop-down list, select Inline grid double.

12. Click Submit. The Dynamic Layout properties panel closes and the layout is now presented as two
rows of two fields each.
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13. Click Save to commit your changes to the Employee Information section.

Add the Employee Information section to the Select Seating Location
form
Update the Select Seating Location form to add the Employee Information section.

1. In the Application Explorer, use the application scoping control to select TGB-HRApps-Work. The
Application Explorer updates to display the contents of the TGB-HRApps-Workclass.

2. Expand Onboarding > User Interface > Section and select SelectSeatingLocation_0. The Select
Seating Location section rule opens.

3. From the Layoutmenu, click Layout and hold down the mouse button.

4. Drag the mouse cursor onto the section above the existing layout. An orange line indicates where
the layout is added to the section.

5. Release the mouse button. The Set layout type dialog opens.
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6. Click OK. A dynamic layout is added to the Select Seating Location section.

7. From the Layoutmenu, click Section and hold down the mouse button.

8. Drag the mouse cursor into the dynamic layout you just created.

9. Release the mouse button. The Section Include dialog opens.

10. From the Page context drop-down list, select Use clipboard page. The Section Include dialog
updates to display the Clipboard page field.
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11. In the Class field, enter or select TGB-HRApps-Data-Employee.

12. In the Clipboard page field, enter or select .Employee.

13. In the field to the right of the By name drop-down list, enter or select EmployeeInformation.

14. Click OK. A Section Include layout is added to the Select Seating Location section.
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15. Click the Employee Information section inside the dynamic layout. A gear icon is displayed to the
right of the section include.

16. Click the Gear icon. The Cell Properties panel opens.

17. Click Presentation.

18. From the Edit options drop-down list, select Read-only (always).

19. Click Submit. The Cell Properties panel closes.
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20. Click Save to commit your changes to the Select Orientation Plan form.

Update the Select Orientation Plan form
Add the Employee Info section to the Select Orientation Plan form. Update the repeating grid to make
the selection flag column editable and remove the label from the column header.

1. In the Select Seating Location section, click the header for the dynamic layout that contains the
Employee Information section include. A gear icon and check mark icon are displayed in the layout
header.

2. Click the check mark icon. The Save Layout as Section dialog opens.

3. In the Purpose field, enter EmployeeInformation.

4. Click Create. The Save Layout as Section dialog closes, and the Select Seating Location section
updates to contain a section include for the Employee Information section instead of the dynamic
layout.

5. Click Save.
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6. In the Application Explorer, expand Onboarding > User Interface > Section and select
SelectOrientationPlan_0_Courses. The Select Orientation Plan section rule opens.

7. From the Layoutmenu, click Section and hold down the mouse button.

8. Drag the mouse cursor onto the section above the existing layout. An orange line indicates where
the layout is added to the section.

9. Release the mouse button. The Section Include dialog opens.

10. In the field to the right of the By name drop-down list, enter or select EmployeeInformation.
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11. Click OK. The Employee Information section is added to the Select Seating Location section.

12. Click Save.

13. In the repeat grid, click the Selection flag field. A gear icon is displayed next to the field.
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14. Click the gear icon to open the Cell Properties dialog.

15. In the Cell Properties dialog, click the Presentation tab.

16. On the Presentation tab, from the Edit options drop-down list select Auto.

17. Click Submit to close the Cell Properties dialog and update the repeat grid.

18. Click the header cell for the Selection flag column.

19. Press the Delete key to delete the label for the column.

20. Click Save to commit your changes to the Select Orientation Plan form.

Update the Review Selections form
Save the Employee Information section to the TGB-HRApps-Work class for use in the Benefits
Enrollment case type. Update the Review Selections form to add the Employee Information, Confirm
Employee Details, and Identify Dependents sections.



182
©2017 Pegasystems Inc.

1. In the Select Orientation Plan section, click the header for the section include. A magnifying glass
icon is displayed in the layout header.

2. Click the magnifying glass icon. A warning dialog informs you that changes to the Employee
Information section are not reflected in the Select Orientation Plan section until you refresh it.

3. Click OK to dismiss the warning dialog. The Employee Information section rule opens.

4. On the Employee Information section, from the Save asmenu, select Specialize by class or
ruleset. The Specialize Section form opens.

5. Under Apply to, enter or select TGB-HRApps-Work.

6. Click Create and open. The Employee Information section rule opens.

7. Click Save to create the section rule in the TGB-HRApps-Work class, for use in both the Onboarding
and Benefits Enrollment case type.

8. In the Application Explorer, expand Benefits Enrollment > User Interface > Section.

9. Under Section, select ReviewSelections_0. The Review Selections section rule opens.

10. In the Review Selections section rule, open the Layoutmenu.

11. Position the mouse cursor over Layout and click and hold the mouse button.

12. Drag the cursor onto the Review Selections section, above the Total benefit cost field. An orange line
indicates where the layout is added to the section.

13. Release the mouse button. The Set Layout type dialog opens.

14. Click OK to select a dynamic layout. A dynamic layout is added to the section.

15. Repeat steps 10-14 twice, to create two more empty dynamic layouts above the Total benefit cost
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field.

16. In the Application Explorer, expand TGB-HRApps-Work > User Interface > Section to list all the
section rules in the class.

17. Under TGB-HRApps-Work > User Interface > Section, click and hold the selection handle for the
EmployeeInformation section rule.

18. Drag the cursor onto the first dynamic layout in the Review Selections section, and position the
cursor over the text in the layout.

19. Release the mouse cursor. The dynamic layout displays the Employee Information form.
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20. In the Application Explorer, under Benefits Enrollment> User Interface > Section, click and hold
the selection handle for the ConfirmEmployeeDetails_0 section rule.

21. Drag the cursor onto the second dynamic layout in the Review Selections section, and position the
cursor over the text in the layout.

22. Release the mouse cursor. The dynamic layout displays the Confirm Employee Details form.

23. Click the Marital status drop-down list. A gear icon is displayed to the right of the drop-down list.

24. Click the gear icon. The Cell Properties dialog opens.

25. In the Cell Properties dialog, click the Presentation tab.

26. On the Presentation tab, from the Edit Options drop-down list, select Read-only (always).

27. Click Submit. The Cell Properties dialog closes.

28. In the Application Explorer, under Benefits Enrollment > User Interface > Section, position the
mouse cursor over the selection handle for the IdentifyDependents_0 section rule.

29. Click and hold the mouse button, then drag the mouse cursor onto the Review Selections section
and into the remaining empty dynamic layout.

30. Release the mouse button to add a section include for the Identify Dependents section.

31. Click the Identify Dependents section. A gear icon is displayed to the right of the drop-down list.
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32. Click the gear icon to open the Cell Properties panel.

33. In the Cell Properties dialog, click the Presentation tab.

34. On the Presentation tab, from the Edit Options drop-down list select Read-only (always).

35. Click Submit. The Cell Properties dialog closes.

36. Click Save to commit your changes to the Review Selections form.

Test your changes
Create a new Onboarding case to test your changes.

1. From the +Create menu, select New > Onboarding. The Collect Employee Info form is displayed.

2. Complete the Collect Employee Info form and click Submit. The Identify Home Office form is
displayed.

3. Complete the Identify Home Office form and click Submit. The Select Orientation Plan form is
displayed.



186
©2017 Pegasystems Inc.

4. Click Submit. The Select Hardware form is displayed.

5. Click Advance this case. The Select Software form is displayed.

6. Click Advance this case. A confirmation form is displayed to inform you that the case has been
routed for approval.

7. Under Open assignments, click Please approve or reject this Approval to advance to the Approval
form.

8. Click Approve. A confirmation form is displayed.

9. Under Open Assignments, click Facilities Setup (Equipment Selection). The Select Seating
Location form is displayed.
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10. Click Submit. The Select Office Equipment form is displayed.

11. Click Advance this case. A confirmation form is displayed to inform you that the case has been
routed for approval.

12. Under Open assignments, click Facilities Setup (Equipment Selection) to advance to the Approval
form.

13. Click Approve. The Confirm Employee Details form is displayed.

14. Complete the form and click Submit. The Identify Dependents form is displayed.

15. Click Submit. The Select Medical Coverage form is displayed.

16. Click Submit. The Select Dental Coverage form is displayed.

17. Click Submit. The Select Vision Coverage form is displayed.

18. Click Submit. The Review Selections form is displayed.
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19. Click Submit to resolve the case.
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Reusing text with paragraph rules

Exercise: Adding instructions to the
insurance plan selection forms

Scenario
When selecting insurance plans, employees have the option to waive each type of coverage. To remind
employees that they can waive medical, dental, or vision coverage, you must add instructions to each of
the benefit selection forms.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Add text to each of the benefit selection forms that states, "Select an insurance plan or elect to waive
coverage."

Detailed steps
Create a paragraph rule containing the instructions for the user. Then, add the paragraph to each of
the Select Medical Coverage, Select Dental Coverage, and Select Vision Coverage sections.

Create a paragraph rule containing instructions for the insurance
selection forms
1. In the Application Explorer, right-click Benefits Enrollment and select Create > User Interface >

Paragraph. The New Record form opens.

2. In the Label field, enter Select coverage instructions.

3. Click Create and open. The Paragraph rule form opens.

4. In the rich-text editor, enter Select an insurance plan or elect to waive coverage.
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5. Click Save to commit your changes.

Add the paragraph rule to each of the insurance selection forms
1. In the Application Explorer, expand Benefits Enrollment > User Interface > Section.

2. Click SelectMedicalCoverage_0.

3. From the Layoutmenu, click and hold the cursor on Layout and drag the layout onto the section
rule form above the existing layout.

4. Release the cursor. The Set Layout Type dialog opens.

5. Select Dynamic Layout as the layout type.

6. Click OK. The section form displays an empty layout, above the layout that contains the Total benefit
cost property.

7. From the Advancedmenu, click and hold the cursor on Paragraph, and drag the paragraph to the
empty layout you created.

8. Release the cursor. The dynamic layout displays an empty layout cell.

9. Click the gear icon to the right of the layout cell. The Cell Properties panel opens.

10. In the Paragraph field, enter or select SelectCoverageInstructions.
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11. Click Submit. The contents of the paragraph rule display in the layout.

12. Click Save to commit your changes.

13. Optional. Repeat steps 1-12 for the SelectDentalCoverage_0 and SelectVisionCoverage_0 section
rules.

Test your changes by creating a new benefits enrollment case
1. Open the Cases Explorer.

2. In the Cases Explorer, click Benefits Enrollment. The Case Designer opens and displays the life
cycle for the Benefits Enrollment case type.

3. In the Case Designer, click Run. The New: Benefits Enrollment form opens.

4. Click Done. The Confirm Employee Details form opens.

5. Click Submit. The Identify Dependents form opens.

6. Click Submit. The Select Medical Coverage form opens.

7. On the Select Medical Coverage form, verify that the new instructions display on the form.
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8. Close the Benefits Enrollment case. The Design Studio returns you to the Case Designer.
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Configuring responsive UI behavior

Exercise: Configuring responsive behavior for
orientation courses

Scenario
New hires participate in a set of orientation sessions as part of the onboarding process. Human
resources (HR) is responsible for selecting the courses for new employees based upon their
employment status, department, and position.

HR has asked that all the columns in the course listing are displayed on a laptop or desktop screen
with a width greater than 1024 pixels. For smaller displays, such as a tablet or smart phone, HR wants
the course description column hidden to minimize horizontal scrolling.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Configure the course listing to adapt to various screen sizes to minimize horizontal scrolling. To do
this:

l In the repeating layout of available courses, set the importance for the Description column to
Other.

l Configure the application skin to drop the Description column for display widths less than or equal
to 1024 pixels.

Detailed steps

Configure responsive behavior on the course listing
Configure the section rule to drop the Description column when reaching the responsive breakpoint:

1. In the Application Explorer, under TGB-HRApps-Work, expand Onboarding > User Interface >
Section.

2. Click SelectOrientationPlan_0. The Select Orientation Plan section rule opens.

3. Click the Grid Repeat Layout header. A gear icon and a check mark icon are displayed on the
header.
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4. Click the Gear icon. The Layout Properties dialog opens.

5. Click the Presentation tab. The Layout Properties dialog displays the presentation options for the
repeating layout.

6. Responsiveness is enabled by default. Verify that the Responsiveness check box is selected.

7. Note that the Style field displays the Default layout format.

8. Click Submit. The Layout Properties dialog closes.

9. In the Repeat Grid portion of the Grid Repeat layout, click the column selector for the Description
column, located above the column. A gear icon is displayed to the right of the column.
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10. Click the Gear icon. The Column Properties dialog opens.

11. From the Importance drop-down list, select Other.

12. Click Submit. The Column Properties dialog closes.

13. Click Save.

Configure a responsive breakpoint for the layout format
Confirm that the skin rule contains a responsive breakpoint defined at 1024 pixels. Verify that this
breakpoint is configured to drop any column with importance set to Other.
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1. From the application menu, select Open application skin. The HR skin rule opens.

2. On the Component styles tab, click the Down arrow icon to open the style format menu.

3. From the Style format menu tab, under Layouts, select Trees & grids. The skin rule displays the
Trees & Grids style format.

4. Under Trees & Grids, click the Inherited tab.

5. On the Inherited tab, select the Default style. The Default style format options are displayed on
the skin rule form.

Note: The Default style format is the style selected in the Layout Properties panel for the Grid
Repeat layout that you configured earlier in the exercise.

6. On the General tab, under Additional styles, click the Enable support for responsive
breakpoints check box. A responsive breakpoint is displayed below the check box.
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7. Under Breakpoint1, verify that Drop columns with importance 'other' is selected. This is the default
setting.

8. The breakpoint is set to 1024 pixels by default. In the max-width field, verify that the value is 1024.

9. Click Save.

Test your changes
Test the responsive behavior of the orientation courses grid by previewing the section and varying the
screen size:

1. Click the SelectOrientationPlan tab. Designer Studio displays the Select Orientation Plan section.

2. From the Actionsmenu, select Preview. The section is displayed in the Preview: Select Orientation
Plan window.

3. Expand the window until the Description column is displayed in the repeating grid.
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4. Resize the preview window and verify that the Description column is dropped from the layout when
the window width drops below 1024 px.

Tip: You can also use Pega Express to preview your changes. To preview the Select Orientation Plan
form with Pega Express, perform the following steps.

5. Note the case ID for the Onboarding case you created.

6. In the lower left corner of Designer Studio, click the Switch to Express mode icon. Pega switches
from the Designer Studio to the Pega Express portal.

7. In the Pega Express portal, under Recent select the onboarding case you created.

8. In the upper left corner of the Pega Express portal, click the display mode icons to preview the
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onboarding case at different display sizes.

Note: If the display mode icons are not available, you must enable editing mode. To enable editing
mode, navigate to the lower right corner of the Pega Express portal and click Turn editing on.

9. In the lower left corner of the Pega Express portal, click the Switch to Designer Studio icon to
return to the Designer Studio.
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Designing a dynamic UI

Exercise: Creating the coverage selection UIs

Scenario
During the benefit enrollment process, new employees have the option of waiving healthcare coverage
plans. For each type of coverage — medical, dental, and vision — the employee completes a form by
either selecting one of the listed options or waiving coverage. If the new employee elects to waive any
type of healthcare coverage, the options for selecting that particular plan should not appear on the
form. If the employee selects a coverage plan, the details of that plan should appear on screen, and the
total cost of benefits should update accordingly.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Configure the three coverage selection forms for benefits enrollment cases. To do this:

l Create three true/false properties to identify if a user intends to waive coverage for each type of
insurance: Waive Medical, Waive Dental, and Waive Vision.

l Add a check box for each property to the corresponding insurance selection section form:
SelectMedicalCoverage_0, SelectDentalCoverage_0, and SelectVisionCoverage_0.

l Add a section include on each insurance selection form to include the HealthcareBenefit section in
the HRPlan data class.

Note: Another system architect created the HRPlan data class for insurance plan data, and created
the HealthcareBenefit section to present this information. You must incorporate this section into
the forms you create using a section include, then configure your forms to pass the insurance type
(medical, dental, or vision) to the section include using a parameter.

l Configure an action set on each coverage selection section to update the display of the section
whenever the user clicks the check box to waive insurance coverage.

l Update the page properties for medical, dental, and vision plans to pass a parameter to only display
plan information for the corresponding type of insurance plan.

Detailed steps

Create properties to capture waived coverage options
Create three Boolean properties to allow users to choose whether to waive each type of coverage.
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1. In the Cases Explorer, select Benefits Enrollment. The Benefits Enrollment case type opens in the
Case Designer.

2. Click the Data model tab. The Case Designer displays the properties used in the Benefits
Enrollment case type.

3. Click Add field. A row is added to the Data model tab.

4. Under Name, enter Waive medical

5. Under Type, from the drop-down list select Boolean.

6. Click Add field.

7. Under Name, enter Waive dental.

8. Under Type, from the drop-down list select Boolean.

9. Click Add field.

10. Under Name, enter Waive vision.

11. Under Type, from the drop-down list select Boolean.

12. Click Save.
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Add each waive coverage property to the coverage selection forms
Add the Boolean properties for waiving coverage to the corresponding coverage selection form.

1. In the Application Explorer, expand Benefits Enrollment > User Interface > Section.

2. Click SelectMedicalCoverage_0 to open the Select Medical Coverage section.

3. In the Application Explorer, expand Benefits Enrollment > Data Model > Property.

4. Click and hold the selection handle for the WaiveMedical property.

5. Drag the property onto the Select Medical Coverage section, below the instruction paragraph.

6. Release the mouse button to add the property to the highlighted layout. An unlabeled check box
appears in the layout.
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7. Click the Gear icon to the right of the cell containing the check box. The Cell Properties panel opens.

8. In the Checkbox caption field, enter Waive medical coverage?.

9. Click Submit. The Cell Properties dialog closes.

10. Click Save to commit your changes to the Select Medical Coverage form.

11. In the Application Explorer, under Benefits Enrollment > User Interface > Section click
SelectDentalCoverage_0 to open the Select Dental Coverage section.

12. In the Application Explorer, under Benefits Enrollment > Data Model > Property click and hold
the selection handle for the WaiveDental property.

13. Drag the property onto the Select Medical Coverage section, below the instruction paragraph.
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14. Release the mouse button to add the property to the highlighted layout. An unlabeled check box
appears in the layout.

15. Click the Gear icon to the right of the cell containing the check box. The Cell Properties dialog
opens.

16. In the Checkbox caption field, enter Waive dental coverage?.

17. Click Submit. The Cell Properties dialog closes.

18. Click Save to commit your changes to the Select Dental Coverage form.
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19. In the Application Explorer, under Benefits Enrollment > User Interface > Section click
SelectVisionCoverage_0 to open the Select Vision Coverage section.

20. In the Application Explorer, under Benefits Enrollment > Data Model > Property click and hold
the selection handle for the WaiveVision property.

21. Drag the property onto the Select Medical Coverage section, below the instruction paragraph.

22. Release the mouse button to add the property to the highlighted layout. An unlabeled check box
appears in the layout.

23. Click the Gear icon to the right of the cell containing the check box. The Cell Properties dialog
opens.

24. In the Checkbox caption field, enter Waive vision coverage?.

25. Click Submit. The Cell Properties dialog closes.
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26. Click Save to commit your changes to the Select Vision Coverage form.

Add the Healthcare Benefit section to each of the coverage selection
forms by using a section include
Add a section include to each coverage selection form to reference the Healthcare Benefit section in
the TGB-HRApps-Data-HRPlan class. Configure each section include to reference the clipboard page
used to store data for the corresponding coverage plan. Specify the value of the Type parameter to
filter the list of coverage options and return data for either medical, dental, or vision coverage plans.

1. Click the SelectMedicalCoverage_0 tab in the Designer Studio. The Select Medical Coverage
section regains focus.

2. From the Layout menu, drag the Section layout onto the Select Medical Coverage section.

3. With the cursor positioned between the two layouts, release the mouse button. The Section Include
dialog appears.
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4. From the Page context drop-down list, select Use clipboard page. The Section Include dialog
updates to reflect the fields needed to reference a clipboard page.

5. In the Class field, enter or select TGB-HRApps-Data-HRPlan.

6. In the Clipboard page field, enter or select .MedicalPlan.

7. In the text field to the right of the By name list, enter or select HealthcareBenefit. The Section
Include dialog displays a parameter table.
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8. In the Value field, enter "Medical".

9. Click OK. The section include is displayed on the section.
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10. Click Save to commit your changes to the Select Medical Coverage form.

11. Click the SelectDentalCoverage_0 tab in the Designer Studio. The Select Dental Coverage section
regains focus.

12. From the Layout menu, drag the Section layout onto the Select Dental Coverage section.

13. With the cursor positioned between the two layouts, release the mouse button. The Section Include
dialog appears.
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14. From the Page context drop-down list, select Use clipboard page. The Section Include dialog
updates to reflect the fields needed to reference a clipboard page.

15. In the Class field, enter or select TGB-HRApps-Data-HRPlan.

16. In the Clipboard page field, enter or select .DentalPlan.

17. In the text field to the right of the By name list, enter or select HealthcareBenefit. The Section
Include dialog displays a parameter table.



211
©2017 Pegasystems Inc.

18. In the Value field, enter "Dental".

19. Click OK. The section include is displayed on the section.
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20. Click Save to commit your changes to the Select Dental Coverage form.

21. Click the SelectVisionCoverage_0 tab in the Designer Studio. The Select Vision Coverage section
regains focus.

22. From the Layout menu, drag the Section layout onto the Select VisionCoverage section.

23. With the cursor positioned between the two layouts, release the mouse button. The Section Include
dialog appears.
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24. From the Page context drop-down list, select Use clipboard page. The Section Include dialog
updates to reflect the fields needed to reference a clipboard page.

25. In the Class field, enter or select TGB-HRApps-Data-HRPlan.

26. In the Clipboard page field, enter or select .VisionlPlan.

27. In the text field to the right of the By name list, enter or select HealthcareBenefit. The Section
Include dialog displays a parameter table.
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28. In the Value field, enter "Vision".

29. Click OK. The section include is displayed on the section.
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30. Click Save to commit your changes to the Select Vision Coverage form.

Add a visible when condition to the HealthcareBenefit section
Add a visible when condition to each of the section includes for the HealthcareBenefit section. If the
visible when condition is true, the HeathcareBenefit section is displayed. Configure the visible when
condition to return a result of true whenever the check box is not checked.

1. Click the SelectMedicalCoverage_0 tab in the Designer Studio. The Select Medical Coverage
section regains focus.

2. Click the header for the section include for the HealthcareBenefit layout. Three icons appear on the
header.

3. Click the Gear icon to open the Layout Properties dialog for the HealthcareBenefit layout.

4. From the Visibility list, select Condition (expression). A field appears to the right of the drop-down
list.
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5. In the field to the right of the Condition (expression) list, enter .WaiveMedical !='true'.

6. Click Submit. The Layout Properties dialog closes.

7. Click Save to commit your changes to the Select Medical Coverage form.

8. Click the SelectDentalCoverage_0 tab in the Designer Studio. The Select Dental Coverage section
regains focus.

9. Click the header for the section include for the HealthcareBenefit layout. Three icons appear on the
header.

10. Click the Gear icon to open the Layout Properties dialog for the HealthcareBenefit layout.

11. From the Visibility list, select Condition (expression). A field appears to the right of the drop-down
list.
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12. In the field to the right of the Condition (expression) list, enter .WaiveDental !='true'.

13. Click Submit. The Layout Properties dialog closes.

14. Click Save to commit your changes to the Select Dental Coverage form.

15. Click the SelectVisionCoverage_0 tab in the Designer Studio. The Select Vision Coverage section
regains focus.

16. Click the header for the section include for the HealthcareBenefit layout. Three icons appear on the
header.

17. Click the Gear icon to open the Layout Properties dialog for the HealthcareBenefit layout.

18. From the Visibility list, select Condition (expression). A field appears to the right of the drop-down
list.
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19. In the field to the right of the Condition (expression) list, enter .WaiveVision !='true'.

20. Click Submit. The Layout Properties dialog closes.

21. Click Save to commit your changes to the Select Vision Coverage form.

Add an action set to the waive coverage check box
Add an action set to the waive coverage check box on each form, to refresh the section whenever a
user clicks the check box. This updates the form to hide the insurance coverage details when the user
decides to waive coverage, or display the insurance coverage details when user declines to waive
coverage.

1. Click the SelectMedicalCoverage_0 tab in the Designer Studio. The Select Medical Plan section
regains focus.

2. Click the layout cell that contains the Waive medical coverage? check box.

3. Click the Gear icon to the right of the cell. The Cell Properties panel appears.
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4. In the Cell Properties dialog, click Actions.

5. Click Create an action set. An empty action set appears on the Cell Properties dialog.

6. Under Action set 1, click Add an event. A pop-up window is displayed.
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7. In the pop-up window, under Other events, click Change.

8. Click Add an action. A pop-up window is displayed.
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9. In the pop-up window, click Display: Refresh.

10. Click Submit. The Cell Properties dialog closes.

11. Click Save to commit your changes to the Select Medical Coverage form.

12. Click the SelectDentalCoverage_0 tab in the Designer Studio. The Select Dental Coverage section
regains focus.

13. Click the layout cell that contains the Waive dental coverage? check box.

14. Click the View properties icon to the right of the cell. The Cell Properties panel appears.
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15. In the Cell Properties dialog, click Actions.

16. Click Create an action set. An empty action set appears on the Cell Properties dialog.

17. Under Action set 1, click Add an event. A pop-up window is displayed.
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18. In the pop-up window, under Other events, click Change.

19. Click Add an action. A pop-up window is displayed.
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20. In the pop-up window, click Display: Refresh.

21. Click Submit. The Cell Properties dialog closes.

22. Click Save to commit your changes to the Select Dental Coverage form.

23. Click the SelectVisionCoverage_0 tab in the Designer Studio. The Select Vision Coverage section
regains focus.

24. Click the layout cell that contains the Waive vision coverage? check box.

25. Click the View properties icon to the right of the cell. The Cell Properties dialog opens.
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26. In the Cell Properties dialog, click Actions.

27. Click Create an action set. An empty action set appears on the Cell Properties dialog.

28. Under Action set 1, click Add an event. A pop-up window is displayed.
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29. In the pop-up window, under Other events, click Change.

30. Click Add an action. A pop-up window is displayed.
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31. In the pop-up window, click Display: Refresh.

32. Click Submit. The Cell Properties dialog closes .

33. Click Save to commit your changes to the Select Vision Coverage form.

Update the plans page properties to read data from a data page
Configure the Medical plan, Dental plan, and Vision plan properties to copy data from a data page. This
data page caches the list of available insurance coverage plans. Provide a parameter to filter the
results from the data page to return only the appropriate insurance coverage options for each
property.

1. In the Application Explorer, under Benefits Enrollment > Data Model > Property, click
MedicalPlan.

2. Under Data Access, select Copy data from a data page. The Data page field appears.

Note: The design of each coverage selection form requires use of a Clipboard page called a data
page to obtain information about a specific type of insurance plan (medical, dental, or vision). In an
upcoming lesson, you learn how to configure data pages.

3. In the Data page field, enter or select D_HRPlanLookup. Under Parameters, the ID field appears.

4. In the ID field, enter .MedicalPlan.ID.
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5. Click Save to commit your changes to the Select Medical Coverage form.

Note: The design of the three coverage selection forms uses a Clipboard page called a data page to
obtain information about a specific type of insurance plan. In an upcoming lesson, you learn how to
configure data pages.

6. In the Application Explorer, under Benefits Enrollment > Data Model > Property, click
DentalPlan.

7. Under Data Access, select Copy data from a data page. The Data page field appears.

8. In the Data page field, enter or select D_HRPlanLookup. Under Parameters, the ID field appears.

9. In the ID field, enter .DentalPlan.ID.
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10. Click Save to commit your changes to the Select Dental Coverage form.

11. In the Application Explorer, under Benefits Enrollment > Data Model > Property, click
VisionPlan.

12. Under Data Access, select Copy data from a data page. The Data page field appears.

13. In the Data page field, enter or select D_HRPlanLookup. Under Parameters, the ID field appears.

14. In the ID field, enter .VisionPlan.ID.

15. Click Save to commit your changes to the Select Vision Coverage form.
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Test your changes
1. Click the Benefits Enrollment tab in Designer Studio. The Benefits Enrollment case life cycle

regains focus.

2. Click Run. The New Benefits Enrollment form is displayed.

3. Click Submit. The Identify Dependents form is displayed.

4. Click Submit. The Select Medical Coverage form is displayed.

5. Click the Waive medical coverage? check box. Verify that the fields for the medical coverage plan
are hidden whenever the check box is checked.

6. Click Submit. The Select Dental Coverage form is displayed.

7. Click the Waive dental coverage? check box. Verify that the fields for the dental coverage plan are
hidden whenever the check box is checked.

8. Click Submit. The Select Vision Coverage form is displayed.

9. Click the Waive vision coverage? check box. Verify that the fields for the vision coverage plan are
hidden whenever the check box is checked.
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Validating user data

Exercise: Validating user entries on forms

Scenario
To avoid processing delays for onboarding and benefits enrollment cases, the human resources (HR)
department asks you to ensure that users provide accurate data when processing an onboarding
request. To avoid invalid user entries, HR requests that you configure the fields so that users must
enter data in the fields. You must also replace some of the text fields in the application with lists.
Finally, HR wants to ensure that the start date for a new hire is entered correctly as a future date.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Ensure that users enter values for the following properties by requiring the listed fields:

l On the Collect Employee Info form — First name, Last name, Start date, Manager, and Email

l On the Identify Home Office form — Office

Replace the text field on the Identify Home Office form with a drop-down list of office locations. To do
this:

l Change the control for the Office property on the form to Dropdown.

l Add a placeholder prompt for the list that tells the user to select an office.

l Source the list from data on the clipboard by referencing the data page D_OfficeList.

Validate the start date for a new employee to ensure that users can only enter a future date. To do this:

l Create a validate rule to apply the edit validate rule IsFutureDate to the employee's start date
(.StartDate).

l Configure the Collect Employee Info flow action to call the validate rule when the user submits the
form.

Detailed steps

Configure the required fields on the Collect Employee Info Form
Add required fields to the Collect Employee Info form. When users submit the form, the application
verifies that the required fields contain data. If one or more fields are empty, the application prevents
submission of the form.
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1. In the Application Explorer, expand Onboarding > User Interface > Section.

2. Click the CollectEmployeeInfo_0 section.

3. Click the Start date field.

4. To the right of the Calendar icon in the field, click the Gear icon. The Cell Properties panel is
displayed.

5. From the Required list, select Always.

6. Click Submit. The Cell Properties panel disappears and an asterisk appears next to the label of the
Start Date field to indicate that this is a required entry.

7. Repeat steps 6-9 for the First name, Last name, Manager, and Email fields.



233
©2017 Pegasystems Inc.

8. Click Save.

Create a drop-down list for the Office field
Replace the Office field with a drop-down list to ensure that users provide a valid value for the Office
property.

1. In the Application Explorer, under Onboarding > User Interface > Section, click
IdentifyHomeOffice_0.

2. Click the Office field. The Cell Properties panel is displayed.

3. To the right of the Target icon next to Text input, click change. A pop-up window containing four
lists of controls is displayed.

4. On the General tab of the Cell Properties form, under Basic input, click Dropdown.
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5. In the Cell Properties panel, notice that the options change to match your selection of a drop-down
list.

6. Click the Include placeholder check box. A field is displayed to the right of the Include placeholder
check box.
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7. In the blank field, enter "Select a home office...".

Source the Office drop-down list from a data page
The list of office locations is available from a data page on the clipboard. Use this data page to
populate the drop-down list with values.

1. Under List Source, from the Type list, select Data Page.

2. In the Data page field, enter or select D_OfficeList.

3. In the Property for value field, enter or select .Name.

4. From the Required list, select Always.

5. Click Submit. The Cell Properties panel disappears.

6. Click Save to commit your changes to the section.
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Create a validate rule to test the value of the Start Date property
For an onboarding case, the start date for the employee must be a date in the future. For other
business processes, this date must be in the past. While the standard IsFutureDate edit validate rule
performs the appropriate validation, it must be called from the process, rather than the property to
satisfy the different requirements for each business process. Create a validate rule to call the
IsFutureDate edit validate rule during the Create Employee Record process.

1. In the Application Explorer, under Onboarding, right-click Process and select Create > Validate.

2. In the New Record form, in the Label field, enter Start date is future date.

3. Click Create and open. The Validate rule form opens.

4. In the Property field, select or enter .Employee.StartDate.

5. To the right of the Property field, click the Add link to open the Validate conditions dialog.

6. In the Select a function field, enter or select Validation of [Property Name] using [Edit Validate
Name] fails.
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7. In the Validation of field, enter or select .Employee.StartDate.

8. In the using field, enter or select IsFutureDate.

9. In the Message field, enter Must be a future date.

10. Click Submit. The Validation conditions dialog disappears.

11. Click Save. The completed condition appears on the form.

Add the validate rule to the to the Create Employee Record process
Configure the Create Employee Record process to call the validate rule when the user submits the
Collect Employee Info form.

1. In the Cases Explorer, click Onboarding. The Onboarding Case type opens in the Case Designer.

2. On the Life cycle tab, select the Create Employee Record process.
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3. In the properties panel, click Open process. The Create Employee Record flow opens on the
Diagram tab.

4. Right-click the connector labeled Collect Employee Info and select Open Flow Action. The Collect
Employee Info flow action opens.

5. On the Collect Employee Info flow action, click the Validation tab.

6. In the Validate field, select StartDateIsFutureDate.

7. Click Save to commit your change to the Collect Employee Info flow action.

Test your changes
Review your changes by creating an onboarding case. Verify that the application directs users to
provide data on the Collect Employee Info form, including a start date that is in the future.

1. From the +Create menu, select New>Onboarding to create a new onboarding case.

2. On the Collect Employee Info form, click Submit. Verify that you are unable to submit the form
until you provide entries in the required fields.

3. In the Start date field, enter or select today's date.

4. Enter information in the remaining required fields.

5. Click Submit. Verify that the Start date field is flagged with a message indicating that the entered
date must be in the future.

6. Correct the error by selecting tomorrow's date.

7. Click Submit. The Identify Home Office form is displayed.

8. On the Identify Home Office form, verify that you are unable to submit the form without selecting
a home office.

9. From the Office list, select one of the values.

10. Click Submit. The application displays Select Orientation Plan form.

Tip: During development, you can update the pyDefault data transform to automatically provide values
for required fields to save time when testing your application. If you do, remember to remove these
initial property values from the pyDefault data transform before your application is released.
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Creating reports

Exercise: Create a report to return available
seating locations

Scenario
When processing an onboarding case, the facilities manager assigns each new employee a seating
location in one of the five TGB offices. The requirement is to use a report definition that identifies the
open seats in each office location. However, when a case is processed, the results should include only
the available seats for an employee's home office. The data source for this report is maintained in the
Facilities department database. The database lists all of the seating locations in each office by ID
number, and indicates whether the seat is available or not available.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create a report to list all of the open seating locations for a specified office.

Create a report definition in the Seating class (TGB-HRApps-Data-Seating). The report returns one
column, ID (.id), that is subject to two filter conditions:

l Only include seating locations for which the status (.status) is "open".

l Only include seating locations for which the location (.location) matches the employee's home office
(.Office).

Note: In this exercise, you create the report to return the needed data from the Facilities database. In
a subsequent exercise, you incorporate this data into the application.

Detailed steps
1. In the Application Explorer, select TGB-HRApps-Data-Seating in the autocomplete field.

2. In the explorer, right-click the class name and select Create > Reports > Report Definition.

3. Create a report definition named Seating Locations.
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4. In the Column source field, enter .id. The property name id appears in the Column name field.

5. Click Save.

6. In the report definition header, right-click Actions and select Run to generate the report. Note that
the results include 50 records.

Create the filter conditions
1. In the Edit filters area, do the following:

a. In the Column source column, enter .status.

b. In the Relationship column, enter Is equal.

c. In the Value column, enter "Open".
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d. Create another row.

e. In the Column source column, enter .office.

f. In the Relationship column, enter Is equal.

g. In the Value column, enter pyWorkPage.Office.

When you are finished, the form looks like the following image.

You have created filter conditions that produce a report showing only available (open) seats in
the employee's office location (identified in the employee's work page on the clipboard).

2. Map pyWorkPage to the Onboarding class.
a. Open the Pages & Classes tab.

b. In the Page Name field, enter pyWorkPage.

c. In the Class field, enter TGB-HRApps-Work-Onboarding.

3. Click Save.
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4. Click Actions > Run to generate the report.

The text in the blue header indicates that the filter for .status is in effect. Note that the filtered
results now show 26 records, compared to the unfiltered results of 50. However, the .office values
are not filtered because no work page on the clipboard exists when you run the report.

5. Verify that the office filter works as expected.
a. In the report header, click the Any office link.

b. In the empty field next to is equal, enter Atlanta.
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c. Click Apply Changes.

The report results change to reflect your filter.
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Optimizing report data

Exercise: Reporting on unresolved
onboarding cases
Caution: Performing this exercise in a cloud environment may lead to issues reading database data in
other exercises. If you are performing exercises by clicking the Open Exercise System link on the
exercise page, we recommend that you skip this exercise.

Scenario
The human resources (HR) department wants to ensure that onboarding cases are processed
promptly. To help track open onboarding cases, HR requests a report that lists each unresolved
onboarding case, grouped by the manager responsible for the case. The report must display the case
ID, home office, start date of the new employee, and current stage for each case returned.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Create a report that displays:

l The manager responsible for the onboarding case (.Employee.Manager)

l The case ID (.pyID)

l The home office of the employee (.Office)

l The start date of the employee (.Employee.StartDate)

l The current stage of the onboarding case (.pxCurrentStageLabel)

Add a filter to the report to skip resolved Onboarding cases.

Group the report results by manager.

Optimize properties to resolve any performance warnings identified for the report.

Detailed steps
1. In the Onboarding class, create a new report definition rule named Open onboarding cases by

manager and office.

2. In the Edit Columns section of the report definition rule form, under Column source, select or enter
.Employee.Manager.

3. Click Add column to create four additional columns.
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4. Add the following properties to the columns you created in step 3: .pyID, .Office,
.Employee.StartDate, and .pxCurrentStageLabel.

5. In the Edit Filters section, under Column Source, select or enter .pyStatusWork.

6. For the filter you created in the previous step, from the Relationship list, select Does not start
with. In the Value field, enter "Resolved".

7. On the Report Viewer tab, enable the Group results option in the Grouping section.

By default, the report only groups results by the first column, which is sufficient for this exercise. To
group by additional columns, edit the upper limit once it appears on screen.

8. Save the report. A message appears on the report, indicating two unreviewed warnings.

9. In the report header, click (review/edit) to view the rule warnings. The first warning indicates that
three properties are not optimized, while the second warning indicates that the report filter may
impact report performance.

10. Under the Informational warning about the report filter, click Add justification. In the field that
appears, enter Report must filter out resolved cases.

11. Click OK. Note that the number of unreviewed warnings decreases to one.

12. In the navigation area of the Designer Studio, open the App Explorer.

13. Verify that the class in the class picker is TGB-HRApps-Work.
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14. Expand Data Model > Property> Employee. Right-click the Manager property, then select
Optimize for reporting.

15. The Property Optimization tool opens. The first screen indicates the property to optimize, and the
number of cases affected.

16. Click Next. The second screen of the tool confirms the selection.

17. Click Next. This begins the optimization process.
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To monitor the optimization process, open the Column Population Jobs Dashboard. The
optimization is complete once the Processed % column reaches 100.

18. Repeat steps 14-17 to optimize the remaining properties mentioned in the rule warning.

19. Return to the report. Save the report and verify that the warning no longer appears.
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Caching data with data pages

Exercise: Creating a data page to populate a
list of seating locations

Scenario
During the onboarding process, new employees are assigned a seating location in one of TGB's five
offices. To ensure that users select a valid seating assignment, HR wants to access a list of seating
locations maintained by the Facilities department. This information should be presented as a drop-
down list, allowing users to select an open seating location in the appropriate office.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Use the Seating Locations report you created in a previous exercise to populate a data page with the
open seating locations in the selected home office. Then update the Select Seating Locations form to
display the open seating locations in a drop-down list.

Detailed steps
To accomplish this task you will:

l Configure the Location drop-down list to use a data page as a source.

l Create a data page named D_SeatingLocations and source the page using the SeatingLocations
report.

l Use the seating location property (.id) on the drop-down list as the value to display and as the value
to set.

Configure the Location drop-down list on the Select Seating Location
form to source data from a data page
1. In the Application Explorer, expand Onboarding > User Interface > Section.

2. Click the SelectSeatingLocation_0 section. The section form opens.
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3. In the Select Seating Location section form, select the Location drop-down list.

4. To the right of the cell containing the Location drop-down list, click the gear icon to open the
Properties panel for the cell.
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5. In the List source section, from the Type drop-down list, select Data Page. When you select Data
Page, additional fields display on the form.

6. In the Data Page field, enter D_SeatingLocation.
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Note: A warning may appear on the Data Page field in the List Source section. This warning informs
you that the data page does not exist. Ignore this warning, as this issue is resolved in the next set of
steps.

Configure a data page to read data from the appropriate database
table
1. Click the crosshair icon to the right of the Data page field.

2. On the New Record form, in the Apply To field, enter or select TGB-HRApps-Data-Seating.

3. Click Create and open. The data page rule form appears.

4. In the Data page definition section, from the Structure drop-down list, select List.

5. In the Data sources section, from the Source drop-down list, select Report Definition.

6. In the Name field, enter or select SeatingLocations.

7. Click Save to save the data page. A warning appears in the rule header.

8. In the rule header, click view to view the warning.
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9. In the Data sources section, in the System name field, enter Seating Locations table.

10. Click Save to save the data page. The warning disappears from the rule header.

Configure the contents of the Location drop-down list
1. Close the data page form. The Designer Studio returns to the Select Seating Location section, with

the properties panel for the Location cell open.

2. In the Property for value field, enter .id.

3. In the Property for display field, enter .id.

4. Above the List source section, click the Include placeholder check box.

5. In the field that appears to the right of the check box label, enter Select a seating location.
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6. Click Submit to close the properties panel.

7. Click Save to save the Select Seating Locations section.

Test your changes
1. From the Actions menu, select Preview. The Preview window opens.

2. Verify that the Locations drop-down contains a list of open offices.

Note: In the Preview window, the list of open offices is not filtered by home office, since the report
relies on the value of the .Office property on pyWorkPage. To fully test the configuration, you must
run the Onboarding process and populate pyWorkPage with data.

3. Create a new Onboarding request.

4. On the Identify Home Office form, from the Office drop-down list, select a home office.

5. Advance to the Select Seating Location step.
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6. Verify that the application only returns a list of seating locations for the selected home office.
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Managing reference data

Exercise: Creating reference data for
Facilities and IT setup

Scenario
During the onboarding process, Human Resources (HR) prepares requests for the Facilities and IT
departments on behalf of the new employee. HR has requested that you create selectable lists for
facilities assets, hardware assets, and software assets for HR partners to complete. HR can then
forward the lists to the Facilities and IT departments to prepare for a new employee's first day at TGB.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Configure data records for the IT and Facilities assets requested for new employees during the
onboarding process. To do this:

l Create an Assets data type.

l Configure a source for the Assets data type with properties to describe IT and Facilities department
assets.

ID (text)

Name (text)

Type (picklist)

l Add records to the source for each asset available to new employees from either the Facilities or IT
departments.

ID Asset type Asset name
F1 Facilities Cubicle
F2 Facilities Office
F3 Facilities Phone
H1 Hardware Laptop
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ID Asset type Asset name
H2 Hardware Desktop
H3 Hardware Mouse
H4 Hardware Monitor
H5 Hardware Docking station
S1 Software Office productivity suite
S2 Software Graphics design suite
S3 Software Virus protection

l Configure forms for the Select Office Equipment, Select Hardware, and Select Software steps in the
onboarding case type to display lists of available assets for selection.

Detailed steps

Create a data type for IT and Facilities department assets
Create the Assets data type, to define the lists of Facilities and IT assets in the application.

1. In the Designer Studio, open the Data Explorer.

2. From the Data Explorer menu, select Add data type. The Add data type dialog opens.

3. In the Add data type dialog, in the Label field, enter Assets.

4. In the Description field, enter IT and Facilities assets.

5. Expand Advanced. An additional field is added to the dialog to specify the parent class.

6. In the Parent class field, enter TGB-HRApps-Data to configure the data type for use in the
HR application.
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7. Click Submit. The Add data type dialog closes and the Assets data type is added to the Data
Explorer and a tab opens for the Assets data type.

Create properties for the Asset data type
Create three properties for the Asset data type: ID, Asset type, and Asset name. Configure Asset type as
a picklist with three entries: Facilities, Hardware, and Software.

1. On the Assets data type form, click the Data model tab.

2. On the Data model tab, click Add field. A row of empty fields is added to the Data model tab.

3. Under Name, enter ID.

4. Click Add field to add a second row of fields.

5. Under Name, enter Asset name.

6. Click Add field to add a third row of fields.

7. Under Name, enter Asset type.

8. From the Type drop-down list, select Picklist.

9. Click the Gear icon in the Asset type row to open the Edit options dialog.
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10. In the Edit options dialog, under List choices enter Facilities.

11. Click +Add choice.

12. Under List choices enter Hardware.

13. Click +Add choice.

14. Under List choices, enter Software.

15. Click Submit to commit your changes and populate a list of values for Asset type.

Add a local data source to the Assets data type
Configure the data source for the Assets data type. Organize the fields for data entry and create data
pages to cache the asset lists on the clipboard.

Create a local data source to store asset records and define the properties used to describe each asset.
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1. On the Assets data type, click the Sources tab.

2. Click Create a local source. The Local Data Storage wizard opens to the Create a local source step.

3. Position the mouse cursor over the selection handle for the ID field.

4. Click and hold the mouse button, then drag the selection handle above Asset name.

5. In the ID row, click the Use as key check box to configure the ID field as the key for the data source.
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6. Position the mouse cursor over the selection handle for the Asset type field.

7. Click and hold the mouse button, then drag the selection handle above Asset name.

8. Click Next. The wizard advances to the Review step.

9. Click Close to complete the wizard and commit your changes to the data model for the Assets data
type.
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Create asset records for IT and Facilities assets
Create the records for IT and Facilities assets, to populate selection lists in onboarding cases.

1. On the Assets data type, click the Records tab.
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2. Click Add record. An empty row of fields is added to the Records tab.

3. Under ID, enter F1.

4. Under Asset name, enter Cubicle.

5. Click +Add record to add a second row.

6. In the second row, under ID, enter F2.

7. Under Asset name, enter Office.

8. Using the contents of the following table, create records for the remaining Facilities and IT assets.

ID Asset type Asset name
F3 Facilities Phone
H1 Hardware Laptop
H2 Hardware Desktop
H3 Hardware Mouse
H4 Hardware Monitor
H5 Hardware Docking station
S1 Software Office productivity suite
S2 Software Graphics design suite
S3 Software Virus protection
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Create the Select Office Equipment form
Configure the Select Office Equipment form to present a list of selectable office equipment to include
in the onboarding case.

1. In the Cases Explorer, click Onboarding to open the Onboarding case type.

2. On the Life cycle tab of the Onboarding case type, select the Select Office Equipment step. The
properties panel for the step opens to the right of the case life cycle.

3. In the properties panel, click Configure view to open the View configuration dialog.

4. Under Fields, enter Facilities.

5. Press Tab to exit the field.

6. From the Type drop-down list, select Field group (list). The View configuration dialog updates to a
row fields under Facilities.
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7. Click the Gear icon to the right of the row for Facilities. The Data Type popup opens.

8. Under Data Type, enter or select Assets.

9. Click Submit. The Data Type popup closes and the View configuration dialog updates to display the
data elements for the Assets data type.

10. Click +Add field to Facilities to add a fourth data element to the field group list.

11. Under Fields, enter Selection flag.
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12. Position the mouse cursor over the selection handle for Selection flag.

13. Click and hold the mouse button, then drag the selection handle above the Asset name row.

14. Release the mouse button to update the order of the list.

15. Position the mouse cursor over the selection handle for ID.

16. Click and hold the mouse button, then drag the selection handle above the Asset name row.

17. Release the mouse button to update the order of the list.

18. Position the mouse cursor over the selection handle for Asset type.

19. Click and hold the mouse button, then drag the selection handle above the Asset name row.

20. Release the mouse button to update the order of the list.
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21. In the ID row, from the Optional drop-down list, select Read-only.

22. In the Asset type row, from the Optional drop-down list, select Read-only.

23. In the Asset name row, from the Optional drop-down list, select Read-only.

24. Click Submit to commit your changes to the Select Office Equipment form.

25. Click Save to commit your changes to the Onboarding case type.

26. In the Application Explorer, expand Onboarding > Data Model > Property.
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27. Under Property, select Facilities to open the Facilities page list property created by Pega when you
added the Facilities field group to the Select Office Equipment form.

28. On the Facilities property rule form, under Data access, select Copy data from a data page to
populate the page list with values from the Assets data type. The rule form updates to display a
Data Page field.

29. In the Data Page field, enter or select D_AssetsList.

30. Click Save to commit your changes to the Facilities page list.

Create the Select Hardware form
Configure the Select Hardware form to present a list of selectable IT hardware to include in the
onboarding case.

1. Return to the Onboarding case type in the Case Designer.

2. On the Life cycle tab of the Onboarding case type, select the Select Hardware step. The
properties panel for the step opens to the right of the case life cycle.

3. In the properties panel, click Configure view to open the View configuration dialog.

4. Under Fields, enter Hardware.

5. Press Tab to exit the field.

6. From the Type drop-down list, select Field group (list). The View configuration dialog updates to a
row fields under Hardware.
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7. Click the Gear icon to the right of the row for Hardware. The Data Type popup opens.

8. Under Data Type, enter or select Assets.

9. Click Submit. The Data Type popup closes and the View configuration dialog updates to display the
data elements for the Assets data type.

10. Position the mouse cursor over the selection handle for Selection flag.

11. Click and hold the mouse button, then drag the selection handle above the Asset name row.

12. Release the mouse button to update the order of the list.

13. Position the mouse cursor over the selection handle for ID.

14. Click and hold the mouse button, then drag the selection handle above the Asset name row.

15. Release the mouse button to update the order of the list.

16. Position the mouse cursor over the selection handle for Asset type.

17. Click and hold the mouse button, then drag the selection handle above the Asset name row.
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18. Release the mouse button to update the order of the list.

19. In the ID row, from the Optional drop-down list, select Read-only.

20. In the Asset type row, from the Optional drop-down list, select Read-only.

21. In the Asset name row, from the Optional drop-down list, select Read-only.

22. Click Submit to commit your changes to the Select Hardware form.

23. Click Save to commit your changes to the Onboarding case type.
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24. In the Application Explorer, from the Application Explorer menu select Refresh App Explorer to
update the contents of the Application Explorer.

25. In the Application Explorer, expand Onboarding > Data Model > Property.

26. Under Property, select Hardware to open the Hardware page list property created by Pega when
you added the Hardware field group to the Select Hardware form.

27. On the Hardware property rule form, under Data access, select Copy data from a data page to
populate the page list with values from the Assets data type. The rule form updates to display a
Data Page field.

28. In the Data Page field, enter or select D_AssetsList.

29. Click Save to commit your changes to the Hardware page list.

Create the Select Software form
Configure the Select Software form to present a list of selectable software applications to include in the
onboarding case.

1. Return to the Onboarding case type in the Case Designer.

2. On the Life cycle tab of the Onboarding case type, select the Select Software step. The properties
panel for the step opens to the right of the case life cycle.

3. In the properties panel, click Configure view to open the View configuration dialog.

4. Under Fields, enter Software.

5. Press Tab to exit the field.

6. From the Type drop-down list, select Field group (list). The View configuration dialog updates to a
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row fields under Software.

7. Click the Gear icon to the right of the row for Software. The Data Type popup opens.

8. Under Data Type, enter or select Assets.

9. Click Submit. The Data Type popup closes and the View configuration dialog updates to display the
data elements for the Assets data type.

10. Position the mouse cursor over the selection handle for Selection flag.

11. Click and hold the mouse button, then drag the selection handle above the Asset name row.

12. Release the mouse button to update the order of the list.

13. Position the mouse cursor over the selection handle for ID.

14. Click and hold the mouse button, then drag the selection handle above the Asset name row.

15. Release the mouse button to update the order of the list.

16. Position the mouse cursor over the selection handle for Asset type.
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17. Click and hold the mouse button, then drag the selection handle above the Asset name row.

18. Release the mouse button to update the order of the list.

19. In the ID row, from the Optional drop-down list, select Read-only.

20. In the Asset type row, from the Optional drop-down list, select Read-only.

21. In the Asset name row, from the Optional drop-down list, select Read-only.

22. Click Submit to commit your changes to the Select Software form.



275
©2017 Pegasystems Inc.

23. Click Save to commit your changes to the Onboarding case type.

24. In the Application Explorer, from the Application Explorer menu select Refresh App Explorer to
update the contents of the Application Explorer.

25. In the Application Explorer, expand Onboarding > Data Model > Property.

26. Under Property, select Software to open the Software page list property created by Pega when you
added the Software field group to the Select Software form.

27. On the Software property rule form, under Data access, select Copy data from a data page to
populate the page list with values from the Assets data type. The rule form updates to display a
Data Page field.

28. In the Data Page field, enter or select D_AssetsList.

29. Click Save to commit your changes to the Facilities page list.

Configure the D_AssetsList data page to return a list of assets filtered
by asset type
Update the report used to source the D_AssetsList data page to filter assets by type. Configure the filter
to accept a parameter. Configure each of the page list properties to pass a parameter to the data page
to return a filtered list of assets to match the page list property.

1. On the Software page list property rule form, to the right of the Data Page field click the crosshair
icon to open the D_AssetsList data page rule.

2. On the data page rule form, under Data sources, click the arrow icon to the right of the Name field
to open the DataTableEditorReport report definition rule.



276
©2017 Pegasystems Inc.

3. On the report definition rule form, click the Parameters tab to add a parameter to the report to
filter report results by asset type.

4. On the Parameters tab, under Name enter Type.

5. Under Data type, from the drop-down list select Text.

6. Click the Query tab.

7. In the Edit filters section, under Column source enter or select .AssetType.

8. Under Value, enter param.Type to select the parameter you created on the Parameters tab.

9. Click Save to commit your changes to the report definition.

10. In Designer Studio, click the D_AssetsList tab to return to the data page rule form.

11. On the data page, click the Parameters tab to add a parameter to the data page.

12. In the Name field, enter Type.

13. In the Description field, enter Asset type.
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14. Click the Definition tab to update the data source to use the parameter you defined.

15. On the Definition tab, in the Data sources section, under the field that contains the report name,
click Parameters to open the Parameters for DataTableEditorReport dialog.

16. In the Parameters for DataTableEditorReport dialog, in the Value field, enter or select param.Type.

17. Click Submit to close the dialog.

18. Click Save to commit your changes to the data page configuration.
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19. In Designer Studio, click the Software tab to return to the Software page list property.

20. From the Actionsmenu, click Refresh to update the property definition. The Parameters section
displays below the Data Page field.

21. In the Parameters section, in the Type field, enter "Software" to pass the text string "Software" to the
data page as a parameter to filter the list of results.

22. Click Save to commit your changes to the page list property.

23. In Designer Studio, click the Hardware tab to return to the Software page list property.

24. From the Actionsmenu, click Refresh to update the property definition. The Parameters section
displays below the Data Page field.

25. In the Parameters section, in the Type field, enter "Hardware" to pass the text string "Hardware" to
the data page as a parameter to filter the list of results.

26. Click Save to commit your changes to the page list property.
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27. In Designer Studio, click the Facilities tab to return to the Software page list property.

28. From the Actionsmenu, click Refresh to update the property definition. The Parameters section
displays below the Data Page field.

29. In the Parameters section, in the Type field, enter "Facilities" to pass the text string "Facilities" to the
data page as a parameter to filter the list of results.

30. Click Save to commit your changes to the page list property.
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Test your changes
Create an onboarding case and verify that the Select Office Equipment, Select Hardware, and Select
Software forms each contain a filtered list of Facilities and IT assets.

1. From the +Create menu, select New > Onboarding to create a new onboarding case.

2. On the Collect Employee Info form, enter values in each of the required fields.

3. Click Submit to advance to the Identify Home Office form.

4. On the Identify Home Office form, from the Office drop-down list select a home office.

5. Click Submit to advance to the Select Orientation Plan form.

6. Click Submit to advance to the Select Hardware form.

7. On the Select Hardware form, confirm that only assets of type Hardware are displayed in the list of
assets.



281
©2017 Pegasystems Inc.

Note: The selection list contains icons to add and delete items from the list a label for each check
box, and a column label for the selection column. These items can all be deleted. To do so, use Live
UI to identify and open the section to update.

8. On the Developer toolbar, click Live UI. The Live UI panel is displayed on the right side of the
Designer Studio.

9. Position the Live UI selection rectangle over the Selection flag column label.

10. Click the mouse button to select the column label.
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11. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

12. In the Cell Properties panel, click in the Value field and delete the contents of the field.

13. Click OK to commit your change to the repeat grid layout.

14. Position the Live UI selection rectangle over the Selection flag check box.

15. Click the mouse button to select the check box.

16. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

17. In the Cell Properties panel, click in the Checkbox caption field and delete the contents of the field.
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18. Click OK to commit your change to the repeat grid layout.

19. Position the Live UI selection rectangle over the Repeat Grid Layout.

20. Click the mouse button to select the Repeat Grid Layout.
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21. In the selection identifier, click the crosshair icon to open the section that contains the repeating
grid of hardware items.

22. On the section, in the Repeat Grid, select the left cell in the Action Top section.

23. Right-click the cell and select Cut. The contents of the cell are removed from the form.
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24. Click Save to commit your changes to the Select Hardware form.

25. In the Designer Studio, return to your open case.

26. On the case form, click Action and select Refresh to update the form with your changes.

27. Click Submit to advance to the Select Software form.

28. On the Select Software form, confirm that only assets of type Software are displayed in the list of
assets.



286
©2017 Pegasystems Inc.

29. On the Developer toolbar, click Live UI. The Live UI panel is displayed on the right side of the
Designer Studio.

30. Position the Live UI selection rectangle over the Selection flag column label.

31. Click the mouse button to select the column label.
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32. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

33. In the Cell Properties panel, click in the Value field and delete the contents of the field.

34. Click OK to commit your change to the repeat grid layout.

35. Position the Live UI selection rectangle over the Selection flag check box.

36. Click the mouse button to select the check box.

37. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

38. In the Cell Properties panel, click in the Checkbox caption field and delete the contents of the field.

39. Click OK to commit your change to the repeat grid layout.
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40. Position the Live UI selection rectangle over the Repeat Grid Layout.

41. Click the mouse button to select the Repeat Grid Layout.
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42. In the selection identifier, click the crosshair icon to open the section that contains the repeating
grid of hardware items.

43. On the section, in the Repeat Grid, select the left cell in the Action Top section.

44. Right-click the cell and select Cut. The contents of the cell are removed from the form.
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45. Click Save to commit your changes to the Select Hardware form.

46. In the Designer Studio, return to your open case.

47. On the case form, click Action and select Refresh to update the form with your changes.

48. Click Submit to advance to the Approval form.

49. In the Open Assignments section, click Facilities Setup (Equipment Selection) to advance to the
Select Seating Location step.

50. Click Submit to advance to the Select Office Equipment step.

51. On the Select Software form, confirm that only assets of type Facilities are displayed in the list of
assets.



291
©2017 Pegasystems Inc.

52. On the Developer toolbar, click Live UI. The Live UI panel is displayed on the right side of the
Designer Studio.

53. Position the Live UI selection rectangle over the Selection flag column label.

54. Click the mouse button to select the column label.
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55. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

56. In the Cell Properties panel, click in the Value field and delete the contents of the field.

57. Click OK to commit your change to the repeat grid layout.

58. Position the Live UI selection rectangle over the Selection flag check box.

59. Click the mouse button to select the check box.

60. In the selection identifier, click the Gear icon to open the Cell Properties panel for the column label.

61. In the Cell Properties panel, click in the Checkbox caption field and delete the contents of the field.

62. Click OK to commit your change to the repeat grid layout.



293
©2017 Pegasystems Inc.

63. Position the Live UI selection rectangle over the Repeat Grid Layout.

64. Click the mouse button to select the Repeat Grid Layout.
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65. In the selection identifier, click the crosshair icon to open the section that contains the repeating
grid of hardware items.

66. On the section, in the Repeat Grid, select the left cell in the Action Top section.

67. Right-click the cell and select Cut. The contents of the cell are removed from the form.
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68. Click Save to commit your changes to the Select Hardware form.

69. In the Designer Studio, return to your open case.

70. On the case form, click Action and select Refresh to update the form with your changes.
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Debugging applications with the
Tracer

Ex: Debugging the Facilities Review routing

Scenario
During a playback of the Facilities Setup process, the process owner observes an error when the case
reaches the Facilities Review assignment. Although a router is configured for the Facilities Review
assignment, the application reports that no routing information has been provided. You have been
asked to identify the source of the error and determine a course of action to resolve the issue, if
necessary.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect SA@TGB rules

Your assignment
Run the Facilities Setup process. When you reach the Select Office Equipment step, enable the Tracer.
When the Tracer is monitoring case processing, advance to the Facilities Review step to observe the
error. Review the Tracer output to determine the source of the error and identify if a fix is needed.

Detailed steps
1. In the Cases Explorer, select the Onboarding case type to open the Case Designer.

2. On the Life cycle tab on the Onboarding case type, select the Facilities Setup process. The Process
Properties panel opens to the right of the case life cycle.

3. In the Process Properties panel, click Open process to open the Facilities Setup flow rule.

4. In the Facilities Setup flow, from the Actionsmenu select Run. The Select Seating Location form is
displayed.

5. Click Submit to advance to the Select Office Equipment form.

6. On the Developer toolbar, click Tracer to launch the Tracer in a new window.
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7. Return to the Designer Studio window.

8. On the Select Office Equipment form, click Submit to advance to the Facilities Review form.

9. Instead of the Facilities Review form, notice that the application returns an error stating that no
routing information has been provided for the assignment.
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10. Return to the Tracer window, which now contains an event log from the application.

11. In the Tracer window. scroll to the bottom of the Tracer output then scroll upward until you locate a
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line marked with the word FAIL on a red background.

12. In the Tracer window, click the word Fail to open the event properties in a new window.

13. Close the event properties window and the Tracer window.

The error reported by the application occurs because no value was set for the property .Office. The
decision table used to route the Facilities Review assignment uses this property to determine the
appropriate workbasket for the assignment. Since the property value was never set in the process, the
router does not function correctly.

This error occurred because the value of .Office is set in a different flow. During normal case
processing, a user selects a value for .Office from a drop-down list as part of the Identify Home Office
assignment, during the Send Welcome Packet process. This list is marked required, so users cannot
submit the form without specifying a value for .Office, so no fix is required.
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Next steps for system architects

System Architect Essentials 7.2 Summary
Now that you have completed this course, you should be able to:

l Apply Pega's principles of application design and development to deliver business applications that
are Built for Change™.

l Use Pega Express to model the life cycle of a case that mirrors the way business people think about
how work is completed.

l Directly capture business objectives to help ensure that business requirements are accurately
captured, and that business and IT stakeholders share a common understanding.

l Use Designer Studio to refine and enhance the case life cycle design.

l Identify the tasks and responsibilities of the system architect on a Pega Implementation.

l Configure a case and case processing behavior.

l Create data classes and properties for use in a Pega application.

l Automate decision-making throughout an application to improve process efficiency.

l Design responsive user forms for use on any platform or browser.

l Design reports to deliver key insights to business users.

l Incorporate and manage reference data to allow applications to adapt to changing business
conditions.

l Test your application design to analyze rule behavior and identify configuration errors.

Next Steps
Completion of Pega System Architect 7.2 helps prepare students for the Certified System Architect
exam. To help you study for the exam, enroll in the CSA Practice Exam course in Pega Academy.
Register for the exam.

http://pearsonvue.com/pegasystems
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